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Introduction to the manual 

 

Applicability 
DriveSize has a long history and it is nowadays available as a Web version and a PC App 
that consists of Global/IEC and US/NEMA versions.   

Technically the DriveSize desktop application contains a framework and variable speed 
drives (VSDSize) and a motion control sizing component (MCSize) having its own section 
in this manual – the chapters 8, 9 and 10.  This manual is mainly for desktop application 
version. Anyway, the web version has about the same layout and functionality. This 
manual instructs you to effectively use DriveSize for selecting motors and drives. 

DriveSize assists in selecting optimal motors and drives for variable speed drives 
applications from ABB low voltage AC drives and 3 phase AC motors – but not including 
the smallest drives nor motors. MCSize is for motion control motors and drives. 

 

Compatibility 
DriveSize is compatible with 32bit/64bit Windows PCs and modern browsers.  

Target audience 
Target audience is anyone who has to select/propose/decide motor and drive types and 
ratings. The stating point is usually load torque, power and speed requirements at motor 
shafts or drive load given in amps.   

You are expected to know the terminology of AC drives and ABB product names thanks 
to marketing literature. 
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Terms and abbreviations 
Term/Abbreviation Description 

Drive Frequency converter for controlling AC motors 

DSU Diode supply unit 

Generating  The operating mode of the IGBT supply unit when 
converting power from the drive back to the AC supply. 

IC International Cooling 

IP International Protection 

ISU IGBT supply unit 

LC Liquid cooling 

Line-up Consists of the supply unit and inverters which have a 
common DC bus. 

Motoring  The operating mode of the IGBT supply unit when 
converting power from the AC supply into the drive DC 
link. 

Overload Defines the maximum required power for short durations. 
The power is overload in percent x base power. The 
overload in percent is normally positive, but a negative 
value means the overload has a different sign than the 
base power. 

One-time at start overload This overload type happens for instance at start. Before 
the next start, it is assumed that the drive has cooled 
down to the ambient temperature. 

RMS Root mean squared 

Temp. rise Temperature rise class of the motor. 

VSD Variable speed drives 

Temp reserve Difference of 80 or 105°C temperature rise of motor 
compared to type tested temperature rise theta θ. 

Global products and regional variants In contrast to global products regional variants are 
marketed on named regions.  

Quick selection Selecting drives without defining drive load. Drive is 
selected based on nominal current and motor power 
listed on catalogues. Selection is based on nominal 
ratings. 
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Overview of DriveSize 

 

DriveSize installation instructions 
Version-specific installation instructions for DriveSize desktop application are given in the 
readme file. The file contains also hardware and system requirements. Read the readme 
file carefully before installing the software. 

Online update 
Since version DriveSize 4.9 this PC App has online update capability. Availability of 
updates on the web is checked once DriveSize has first time installed and then always 
when started. Update dialog pop-up window appears with OK/Cancel options when 
update exists. Select OK for immediate update or push Cancel if you want to postpone 
installation. Administrator rights are not required! 

Program structure 
DriveSize consists of a user interface, computing part and product databases. The 
databases contain about 85 000 data rows for catalog motors with many voltages, 
thousands of drive types and the modules of the drives. The computing of customer-
specific motors is based on ABB Sophiè, which has been developed by ABB Oy / 
Machines. 

The program follows the common user interface guidelines of Microsoft Windows.  

The dimensioning cases are called projects. You can save the selection results for the 
project into a project file (XML file). You can generate OpenXML based technical reports 
and you can attach the reports to project and drive documentation. 
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DriveSize functions 
DriveSize contains the following relevant items for electric drive dimensioning: 

 Ambient conditions for drives and motors 

 Four different mechanical load types for motor: 

 Constant power 

 Constant torque 

 Constant torque and power 

 Squared torque (Pump/fan) 

 Overload types available: 

 One-time at start 

 Simple cyclic 

 Multiform cyclic 

 Drive selection based on loading currents 

 Simple cyclic 

 Multiform cyclic 

 Selecting an alternative inverter, a motor and a line supply unit manually 

 Drive and motor selection with sine filter 

 Network harmonics calculation for drives or supply units and combined 
harmonics  

 Harmonics calculations for mixed single drives systems 

 Heat loss calculations for most motors and drives 

 Show IEC61800-9-2/EN50598-2 loss numbers for most new drives 

 Mass flow and thermal loss for liquid cooled multidrives 

 Results in numerical form 

 Results in graphical form (load, motor, inverter) 

 Generating reports in openXML format for saving or printing 

 Saving and retrieving projects with *.AC and *.MAC files   

 Save information in XML format to be used with other software 

 Option to consider motor load RMS or not 

 Option to Utilize temperature reserve of IEC34 motors or not. 

 Handling of regional variants of drives 

 Transformer selection results and reserves 

 Lock option to keep selected motor 

 

DriveSize Help 
The HTML help includes information on using the program. You can access the Help 
through the Help menu or by pressing F1. The Help is context sensitive and when F1 is 
pressed, it automatically opens a help window associated with the active function of the 
program. 
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Dimensioning of drive system 

 

Contents of this chapter 
This chapter describes how to create a new project or open existing one and then how to 
select one or more motor drives for known motor loads or currents loading the drives or 
by quick selection. 

To start a new project 
The following is an overview of the tasks for project level.  

1. Double-click a product category in the New project selection. Within each category 
you can select drives series within that category. Then enter the general project 
information and check optional regional variants with Project Info on the File 
menu. 

2. If ambient conditions deviate from normal, select Ambient Conditions on the 
Data menu or toolbar and set new ones. Quick selection assumes nominal 
ambient conditions. 

3. If the network data, voltages and frequency deviate from your previous settings, 
change them from main window. Highlight a network/transformer in System 
configuration. 

4. Then start to fill in load requirements for first motor or drive or use for example 
copy paste to get all drives listed. The drive series can be changed within the 
limits of category selection. The Tools/Option setting for “Quick selection” 
determines the selection method of first drive in system configuration. 
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When you start DriveSize without a project file, the New view opens. Select the 
interesting tile, which describes best your needs.  

 

 

Figure 1: Start new project: desktop application and web versions. 
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To change project information 
Use Project Info on the File menu to enter new project data. DriveSize saves this 
information when you save your project and includes it in your reports. The possible 
regional variant selection is also saved for your convenience.  

Figure 2: Project information  

 

To set ambient conditions 
Use Ambient Conditions on the Data menu if you need to change the default ambient 
conditions. The dependency of the altitude to the loadability varies with different 
components. The practical range of ambient temperature is usually from 30°C to 50°C. 
This varies with the component. For example, a temperature up to 55°C is accepted for 
ACS880 single drives and marine drives but Ex motors are not selected at all if the 
ambient temperature exceeds 40°C. 

Figure 3: Ambient conditions 

 

The main dimensioning window 
After opening or creating a project the main window opens. 

Motors, drives, inverters, line supply units, transformers and the network have different 
data input displays. When you select an item in the System configuration field, the 
related input data displays are shown.  
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Figure 4: The main VSDSize window – desktop application and web versions. 
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The main window of desktop application version contains  

 System configuration field  

 Input data and specification field  

 Selected data field to show component data 

The title bar displays the name of the project.   

Select from System the item to be selected. Use a toolbar icon, a menu command, 
context sensitive menus or press Ctrl+E to start the selection process. You can make the 
dimensioning one by one (Ctrl+E) or dimension all units at the same time (Ctrl+A). 

The toolbar provides quick click access to common commands. The purpose of buttons 
is shown on tool tips in desktop application version and text in Web version.  On desktop 
application version the ambient information is shown on toolbar as well. 

 

System configuration 
The System configuration show an overview of the drive system as well as the type 
designation or name of each unit in the Tree structure.  Figure 4 shows an example of a 
multidrive tree where selections have not yet been made.  Multidrive tree is more 
complicated than others. 

The Motor load, Inverter load, Line supply unit load, Network data and Transformer 
load views appear in the input data field depending on which unit you select in the 
System.   The respective catalog data for the motor, the inverter, the line supply unit or 
the transformer also appear in the selected data field upon selection. 

 

Mains and transformer data 
The primary voltage does not have effect on motor and drive choices but if you select a 
value that is too high, it prevents you from selecting a transformer. The default system 
frequency is 50 Hz or 60 Hz. The system frequency has a direct effect on possible 
secondary voltage levels as well as on the motor databases. The logic of DriveSize 
assumes that in the 60 Hz countries the standard motors are 60 Hz motors only. This 
limitation is not valid with the AC Drives. Three winding transformers go together with 12-
pulse drives only. 

Short-circuit power is essential when network harmonics are calculated.  

DriveSize calculates the transformer load power from the motor base powers and 
efficiencies and power factors. You can allow DriveSize to use these values, but you can 
use your own values. 
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The software includes Oil immersed and Vacuum Cast Coil Dry types of transformers. 

Figure 5: Network/mains data and Transformer load definition 
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Input data for motor or for drive 
A new project has one drive on System configuration, but idea is to have all drives and 
motors supplied from one transformer into one project. DriveSize limits the possible drive 
types according main category but within one category a mixture of different drives is 
supported.  For example, a mixture of ACS550 and ACS580 is valid. There is also Single 
drive combination category where drive types from other single drive categories can be 
mixed. This is useful when drives from different drives categories are connected to one 
common transformer. Then it is possible to calculate harmonics content or select the 
correct size of transformer for that combination.  

Each motor drive is independent. But with multidrives the supply unit effect the inverter 
and motor selections.  The supply unit type is usually chosen manually based on the 
required functionality and it also dictates the inverter types (air/liquid cooled; 
ACS800/ACS880, ISU/DSU). Also, three winding transformers go together with 12-pulse 
drives or supply units only. 

There is basically three ways to get a drive selected: a) select first the motor and then 
drive or b) select the drive based on known drive currents or c) quick select the drive 
based on catalogue nominal current and/or nominal motor power. 

Procedure to enter motor load and then select drive  
1. To enter load for motor, highlight motor in System.  Give at least the base power 

for motor shaft.  Then you use DriveSize to select the motor.  

2. Let DriveSize to select the drives or inverters once the motors have been 
selected. You can also manually select the drives.  And you can overwrite the 
calculated currents as well. 

Procedure to enter drive currents to select drive  
1. To enter load only for drive, highlight drive/inverter in System and don’t give even 

base power for motor. Drive currents are typed directly to Drive load screen or into 
Overload currents.  Then DriveSize ignores all motor parameters and computes 
the drive based on given currents, cos and frequency range only.  

2. This stage is identified by DriveSize by greying the Motor power values. 

3. To be able to change to motor mode clear all overload inputs or delete the System 
configuration branch.  

Quick selection procedure 
1. Insert Drive form menu and type in required Current rating [A] and/or Motor power 

[kW]. 

2. Let DriveSize to select the drive. You can also manually select the drives. 
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Load data for motor  
DriveSize supports four characteristic load types for motor: 

A) Pump/fan load (Squared torque) 

B) Constant torque 

C) Constant power 

D) Const. torque/power (combination) 

DriveSize supports the following overload types for motors: 

A) Simple cyclic = Cyclic duty will continue forever without interruptions, 
repeating itself at least a time where both motor and drive are thermally stable.   

B) Multiform cyclic = Cyclic duty to have multiple (max 10) overload definitions in 
sequence, repeating all of them at least a time where both motor and drive are 
thermally stable.  If motor has N overloads, then multiform overloads for drive has 
also N overloads. 

C) One-time at start = Not cyclic, the drive has cooled effectively down prior 
starting.  

Ex motors have special limitations for overload lengths.   

If you select Multiform cyclic and you have already given base Power, the Overload 
definitions dialog opens. You can also open it on the toolbar by selecting, for example, 
Duty cycle. The Overload definitions are explained in detail in chapter Special features. 

Figure 6: Motor load data 

To enter motor speeds and loads 

The Motor speed and Motor load input fields vary with different load types. 

ABB does not sell gears and DriveSize/VSDSize assumes all speed and load are 
converted at motor shaft.  Therefore DriveSize/VSDSize does not offer gear ration 
optimization, but that is an important part of good drive system design.   

DriveSize/VSDSize does not consider dynamic torques.  When remarkable dynamic 
torque exists, include it as short-term overloads. 

 

Base speed 
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Base speed is the shaft speed of a motor where the base power is required.  Use exact 
values for base speed. Use all digits like 1456 (not 1500) because the rated speeds of 
motors are also exact.  In the US the tradition has been to use round numbers. 

 

Base power 

Base power is the required mechanical power from motor shaft. This is used as the base 
value for all overloads. Note that motor thermal selection is based on worst 10 min RMS 
by default. Do not include the overload twice. It is possible to skip RMS computing for 
motor selection. Select Skip RMS-computing of overloads from Tools menu’s 
Options. If you have problem with Base power but know the overloads accurately you 
can use a round or convenient number like 10 kW, 50 kW or 100 kW and type in 
overload% based on the base value you selected. Base power is normally positive but 
negative values are acceptable. 

Fill in the required load that is on the shaft – not the rated power of the motor. Specify the 
real required shaft power of the loading machine. In VSD applications, the motors are 
always slightly derated. 
 

Base overload 

Base overload defines the maximum required power together with base power for the 
overload time. The power is overload in percent x base power. Overload in percent is 
normally positive. A negative value means that the overload has a different sign than the 
base power.  The overload is assumed to exist anywhere between the minimum speed 
and maximum speed. 

Min speed 

If the minimum speed is too low compared to the real need, DriveSize selects for the 
motors and drives a size that is larger than necessary. In DriveSize, the minimum speed 
is not exactly the minimum speed of the motor but a speed that is used without 
interruptions of, for example, 30 minutes. DriveSize assumes that the duty cycle 
continues without stopping and DriveSize selects the motor and drive accordingly. If the 
minimum speed is critical, you can see it from the results/graphs. The default minimum 
speed is provided due to usability reasons, but you should consider this in every case. 

Max speed 

A maximum speed that is too high can have a negative impact on the motor size. If the 
maximum speed is much higher than the base speed and the overload in percent is high, 
the absolute maximum torque of the motor can be a limiting factor. 

Overload at max speed 

Due to the reasons stated above, the overload in percent at maximum speed can be 
given a different – normally lower - value than the overload in percent at base speed. This 
is valid for constant power load types. 
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One-time overload at start 

 

Figure 7: Motor input data   
 

OL [%] 

The starting torque is OL% x base torque. The base torque is calculated from the base 
power and base speed. The valid range for OL% is from 1% to 1000%. 

OL time is the duration of the starting overload in seconds. 

OL max speed tells DriveSize at which speed the overload ceases. Use low values. If 
the OL maximum speed is equal to the base speed and OL% is high, the power limit of 
the inverter can force DriveSize to select a larger drive. 

 
 

To change motor specifications 

You can specify the preferred motor type, frame material, IP class, IC class, temperature 
rise class and so on. Click the item to change a selection. Refere to Table 1. 
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Table 1: Options for Motor Specifications 
Name Name of motor, to display Name in System configuration, go to Tools -> Options-

> Unit name. DriveSize displays the type codes of motors by default. 

No. of motors 1...100 per inverter unit. A factor DriveSize considers when it selects an inverter. 
The load is given for one motor.  

Motor type The list varies according to supply voltage and Drive product series. 

Existing   = means there is no need to reselect motor 

IEC 34 motor = IEC600034 type  

HXR, AMI, NXR Motors – customer-specific with industrial drives     

NEMA catalog – North American, US version 

Marine motors  

Water cooled 

PM motors  

Flameproof, Non-sparking, Dust ignition protection  

SynRM (reluctance motor), Low inertia HDP 

High speed motors (M3BC) 

User defined  

ProductionUnit Production unit filter with dynamical behaviours. Not specified, CN, PL, FI, ES. 
Any combination of production units is possible! 

FrameMaterial Not Specified, Aluminium, Cast iron, Welded steel. 

Family Limits the search to one family only, such as M3BP. 

Polenumber Pole number can be Automatic or one of the following: 2,4,6,8,10 or 12 

Term. box location  The location of terminal box. Top, Side or N-end.  

Efficiency Not Specified, IE1, IE2, IE3, IE4. You can limit the motor efficiency class. Any 
combination of IE classes is possible! 

Winding Motor voltage code selection. Standard and restamp, All winding. Motors with 
special design are included in All winding option. 

Design Read more about Design from the motor user manuals. 

Connection Connection with rated motor data. Not specified, Y, D. 

IP Class IP55, this does not impact the selection. IP23 and IP54 options available for Low 
inertia HDP. 

IC Class IC411 self ventilated = cooling fan on motor shaft; means lower loadability at 
partial speeds 

IC416 forced ventilated = separate cooling fan. Select this option for constant 
torque cases where the minimum speed is very low. 

For large motors there are other selections available. 

TEFC etc for US 

Max speed rule 

 

 

 

Standard = Standard maximum speeds is used. 

Metal fan = The higher speed limit of the metallic fan is used. 

Separate fan = Higher maximum speed is available when force ventilated. 

For low inertia motors 4 different choices. 

Insulation Standard or Special insulation. Special winding insulation is required in VSD use 
when voltage is higher than 600V. Optional for other voltages.    
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Temp. rise B, F or not specified. Not specified means that DriveSize will use the 
temperature class given in motor catalogues. 

Temp reserve Keep = traditional loadability curves 

Utilize= Utilize temperature reserves based on measured temperature rise in 
database and the Temp rise just selected above.   

 

Tmax margin 43%, 30% or 20%. Motor catalogues give rough maximum torque values and 
some margin must be provided. The margin from actual overload torque to Tmax 
must be 43%, 30% or 20%. 

 

User Profile 

DriveSize has default settings. Certain default settings can be changed. These options 
are available in Tools menu’s User Profile. The following motor specifications can be 
changed  

1. Winding 

2. Design 

3. Temp rise  

4. Tmax margin 

5. Temp reserve  

 

Motor selection 

DriveSize usually selects the most suitable motor from the technical point of view 
considering specifications.  However, if you want to select another motor you can choose 
an optional motor from the Manual selection list. Figure 20: Manual selection view for 
drive shows the alternative selections. Filter options are available for Code and PU items 
i.e. generation code and production unit.  

Lock motor 

Activate Lock checkbox from System configuration/Selected motor data to keep certain 
motor regardless of load settings.  

Note: the thermal load capability of motor can be exceeded, and negative margins are 
possible. 

 

Utilize temperature reserves of IEC 34 motors 

On the catalogues ABB motors are labelled as Class B or Class F temperature rise. The 
insulation system and materials are normally good for Class F temperatures to guarantee 
long lifetime of motors.   The demand of high efficiency has forced the designers to use 
more and better iron and conductor materials and effective cooling.  The result is that the 
temperature rise with nominal load is less than 80 °C.  Together with rated ambient 
temperature 40°C the stator winding temperature is less than 120°C.  Motor has by 
design temperature reserve which can be used without harmful effects to windings. 

When motors are running 24h/7d per week - year after year - the energy cost tend to be 
main part of total cost.  In this case it is natural to use best possible motors, and in power 
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levels, where the efficiency is best.  To compute the losses of motor is relatively easy 
because the winding temperature of motor is same as during type test.  Select the Keep 
temperature reserves choice on DriveSize. 

But for example, for intermittent or short time or burst duty the most economical selection 
can be compact motor where the temperature reserves are fully utilized.  One way to 
describe this kind of duty is that motor is idling or in standstill a lot per year.  Select the 
Utilize option.  Estimate the losses and together with running hours determine the lost 
energy.  Now this should be one selection criteria together with optionally more compact 
motor.  Sometimes the smaller motor will help to reduce the drive rating –normally not.  
The reason is that the electrical power required by motor depends on motor load not the 
motor parameters so much.  

In DriveSize the measured temperature rise is shown on Motor data. This reserve is not a 
global parameter but is individually given to each motor and supply voltage. The reserves 
are measured during type tests of motors.   

Instead of standard temperatures 80°C and 105°C DriveSize use as target temperatures 
78°C and 95°C.   If for example the real temperature rise is only 55ºC then the difference 
between Keep and Utilize is about  

78/55 = 1,19 

As a conclusion, this motor  able to handle 19% more load compared to a motor with 
assumed temperature rise of Class B.  Considering also the time constants of motor this 
means technical advantage but requires know-how.   

If Utilize is selected DriveSize will scale the loadablity curves upwards and result torque 
numbers upward provided the measured temperature rise is less than 80C. 

Utilize is as a default setting of Temp reserve in motor specifications. Default setting can 
be changed from User Profile under Tools menu. 

Additional derating requirements 

 
Note: Check the availability of force ventilation and accessories from the motor 
manufacturer. 
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Load data for drive or inverter 
This section describes how to enter the single drive/multidrive inverter load and 
specifications in two cases with motor or without.  

The load of the inverter consists of currents, frequencies and voltages.  

Basic feature is that, DriveSize calculates the load currents based on the selected motor. 
The plural is used here to indicate different load points namely: min, base and max.   You 
can edit current values without effecting the motor selection with simple cyclic.  With 
Overload currents dialog you may edit inherited frequencies, currents and cos phi values, 
but you may not add more loading points.  See chapter Special features.  

The other choice is that you know the loading currents and type those values directly with 
simple cyclic or Overload currents screen with frequency and cos phi.  The drive load is 
considered cyclic or multiform cyclic. “One-time a start” is not supported.  Please notice 
that a negative cos phi means electrical braking. See chapter Special features. 

 

Figure 8: Simple load data for inverter with motor and multiform overload currents given 
by user without motor.  

 
Table 2: Abbreviations used for inverter load  

I continuous (A) Continuous current required from the inverter and 
calculated value.  If you enter this value manually 
and if the motor is not known, DriveSize assumes 
that the frequency range is wide. 

I maximum (A) Maximum current required and calculated value. If 
you enter this value manually and if the motor is 
not known, DriveSize assumes that the frequency 
range is wide. 

To change Drive/Inverter specifications 

You can adjust specifications for the Drive/inverter, such as the IP class and mains pulse 
number.  The multidrive inverter settings are determined by the selections from the 
supply unit.  
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Table 3: Options for drive/inverter specifications 

Name Name for the drive. 

No. of drives Number of parallel connected inverter and motor combinations. 

Type Product series.  With multidrives the type is automatically selected 
according to supply unit; please refer to marketing material.  With 
industrial drives Auto, selection includes all drives ACS880 and 
constructions but not modules and marine types.    

Construction Wall-mounted, Cabinet, Marine, Module, Flange module 

Cooling Air, Liquid.  

Note:  Liquid cooling is available only for the Cabinet construction. 

IP Class IP20 …IP55. Depends on Type and Construction specifications. 

Pulse 6 or 12. When the 12-pulse option is selected, the transformer must 
be of a three-winding type. 

For machinery drives this field is used to identify “3-phase 6 pulse” 
and “1-phase full-wave” 

Sine filter No, Yes. Available for certain ACS880 drives with induction motor. 

Grid voltage Relative grid voltage level from -15 % to +15 %. This is an additional 
sine filter specification. 

Cable length Cable length when sine filter is used. Adjustable length from 10 m to 
300 m. Default is Not Specified. 

Cable size The size of motor cable [mm2] when sine filter is used. Cable size 
options are 2.5, 4, 6, 10, 16, 35, 50, 70, 95, 120, 140, 240, 370, 480, 
555, 720. Automatic is a default specification and then size is 
automatically selected. 

Glycol concentration 25%, 50%. For liquid cooled units only. 

Liquid temperature 25°C…46°C. For liquid cooled units only. 

EMC category 

Variant  

Used to build the complete type code of machinery drive 

Min Switching freq. Some drives have minimum switching frequency as selectable 
option. Too low values do not prevent drive selection.  

 

Drive/Inverter selection in general and manual selection  

DriveSize usually selects the most suitable inverter/drive from the technical point of view 
considering specification.  However, sometimes you may want to select another 
drive/inverter. In these cases, you can choose an optional drive/inverter from the Manual 
selection list.  Figure 20: Manual selection view for drive  shows this screen for motors 
but similar screen is available for inverters and drives too. 

 

To select liquid cooled drive/inverter 

When you select the liquid cooled drive option in the Cooling specification, two new 
specifications Glycol concentration and Liquid temperature appear. For a multidrive, 
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select liquid cooling for the supply unit first.  The cooling method of the supply unit 
determines also cooling for all the inverters connected to that line-up. 
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Line supply unit data 
This section describes the line supply unit data input for multidrives.  

  

 

 

 

 

 

 

 

 

 

 

Figure 9: Line supply unit input data and specifications 

 

To enter line supply unit load 

If you have selected the motors and inverters, DriveSize calculates the supply unit 
motoring default powers. The view has also fields for regenerative powers when the 
supply unit type is RRU or ISU.  Please review the numbers in any case. 

 
Table 4: Abbreviations used to describe the supply unit load 

Pcont (kW) Continuous power for the supply unit. 

Pmax (kW) Maximum power for the supply unit. 

 

To change line supply unit specifications 

The default supply unit is a 6-pulse DSU cabinet, but other types and pulse numbers and 
IP classes are available. 
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To select liquid cooled supply unit 

When you select the liquid cooled (LC) supply option in the Cooling specification, two 
new specifications Glycol concentration and Liquid temperature appear. These 
specifications also determine all the inverters connected to that supply unit. The cooling 
method of line supply unit is valid also for all the inverters connected to that line supply 
unit. 

 
Table 5: Options for Line Supply Unit Specifications 

Name Name or string to identify supply unit 

Series ACS800, ACS880 or ACS860 

Type Supply units with different technologies.  See the marketing material: DSU, 
ISU, DxD, DxT and RRU on cabinet and some also as modules.  

IP Class IP00, IP21, IP22, IP42, IP54 

Cooling Air, Liquid. 

This option determines also the cooling method for all the inverters 
connected to that line-up. 

Pulse 6-pulse, 12-pulse, 18-pulse, 24-pulse. When the 12-pulse option is selected, 
the transformer must be of a three-winding type. 

Glycol concentration 25%, 50%. For liquid cooled units only. The supply unit determines also 
glycol concentration for all the inverters connected to that line-up. 

Liquid 

temperature 

25 °C … 46 °C. For liquid cooled units only. The supply unit determines also 
liquid temperature for all the inverters connected to that line-up. 

 

 
 

 

 

Inputs for quick selection procedure 
 

The category and supply voltage are inherited for these drives in the same way as other 
drives.  Also, the specification part is valid and for example regenerative drives can be 
selected as well as normal diode bridge drives. Then selection is done based on required 
Current rating [A] and Motor power [kW]. Motor is assumed be a regular induction motor. 
The given values are compared to nominal ratings of drives, which are nominal current 
and typical motor power.  

  

 

 

System icons and status 
The selection status of System item is shown with tooltip and icons (desktop application). 
Table 6 describes the meaning of the status icons. 
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Table 6: Status icons 

Status Icon Meaning 

MULTIDRIVE SUPPLY 
UNIT 

 

Line supply unit is not selected. 

 

Line supply unit is selected. 

 

Line supply unit selection is not valid. 

INVERTER OR DRIVE 

 

Inverter unit is not selected. 

 

Inverter unit is selected. 

 

Inverter unit selection is not valid. 

MOTOR 

 

Motor is not selected. 

 

Motor is selected. 

 

Motor selection is not valid. 

 

System configuration displays the type designation or name of the unit depending on 
what you have selected in Options. 

Inserting, copying or deleting components 

Use Insert and Edit on the menu bar when inserting, copying or deleting components in 
the System. For copy-pasting, you must, for example, highlight the drive you wish to 
copy and paste it on top of a transformer. The pasted drive is displayed as the last item in 
the tree. 

The Insert menu have two choices: Insert Drive and Insert Drive + Load. 

With multidrives the choices are Insert Inverter, Inverter + Load, Line supply unit + 
Inverter, Line supply unit + Inverter + Load. 
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Highlighting components 

When you click an item in the System tree, it is highlighted as your working item and the 
input data and possible selected item appear. 

Tip: You can highlight several components at one time. When you highlight several 
components at one time, it is easier to copy (copy-paste) or delete a group of 
components or move (cut-paste) them from one line to another. To highlight components, 
use the Ctrl key, mouse and left mouse button. Press and hold down the Ctrl key when 
selecting the components. 

Figure 10: Highlighting several units at a time  

Dragging and dropping 

You can move an inverter or line supply unit to another location in the System tree. 
Highlight the component you want to move. Press the left mouse button, move the 
component to a new location and release the mouse button. If you want to drag the unit, 
each component must be separately moved. 
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Automatic track 

The program always keeps up the sizing status. If you change input data, which can have 
effect on the other units, then those selections will become invalid. 

 
Table 7: DriveSize sizing updating 

Changed data Sizing not valid for 

Motor ambient conditions All motors, inverters and line supply units 

Drive ambient conditions All inverters and line supply units 

Network voltage All motors, inverters and line supply units 

Network frequency All motors, inverters and line supply units 

Supply unit load Only the line supply unit whose load you changed 

Line supply unit type, motor voltage or braking 
voltage 

All motors, inverters and line supply units in that 
line-up 

Line supply unit IP class Only line supply unit whose IP class you changed 

Inverter load Only the inverter and line supply unit where the 
inverter is connected 

Inverter IP class Only that inverter and line supply unit where the 
inverter is connected 

Motor load Only that motor and inverter where the motor is 
connected. Also, that line supply unit in that line-up 

Motor number, type, IC class or Temp. rise Only that motor and inverter where the motor is 
connected. Also, that incoming unit in that line-up 

Inserting motor and inverter Only the line-up’s line supply unit 

Deleting or pasting motor and inverter Only the line-up’s line supply unit 

Selected motor The inverter where the motor is connected. Also, 
that line supply unit in that line-up 

Selected inverter Only the line-up’s line supply unit 

 

To open a saved project 
1. Select Existing to open a previously saved project. The Existing view shows all 

Recent folders where project files exist.  

2. Click an appropriate folder to see all available projects.  

3. Highlight a project file and double-click to preview Project Info before opening the 
project.  

4. Click Load push button to open that project file. Figure 11: Opening project view 
shows the Existing view. Last saved files are shown in Recent view.  
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Project file can be opened also by double-clicking it. Then software is started, and project 
opens directly to the main dimensioning window.  

Select Open from File menu to open a project file through the main dimensioning 
window. The Existing view appears.  

 

Figure 11: Opening project view  

 

Options and retained settings 
 

DriveSize will save into registry the last supply voltage setting and frequency. Previous 
version setting Global/US has been stored.  And the favourite project directrory. 

The Tools/options dialog show three settings: a) what names are shown on system tree, 
b) whether RMS computing is used for motors or not (all of them)  and c) whether the 
default is keep or utize for the motors temperature reserves.   The traditional way is keep 
and it offers the best efficiency solutions. 
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Special features 

 

Contents of this chapter 
This chapter describes the special features of DriveSize, such as creating more 
sophisticated load definitions. This section also describes how to use special motors and 
how to create your motor database. 

Motor load 
Enter the motor base load in the main window. If the load is more complicated continue 
with toolbar button Duty Cycle or from menu Overload definitions. See Figure 12: 
Overload definitions 

Many overloads 
1. Define the duty load by intervals and loads in percent on top of base power or with 

power or with torque values.  

2. To enter these values, click a cell in the table and type the new value. Use the 
arrow keys on your keyboard to move inside the table.  

3. To accept your custom duty cycle, click OK. If you click Cancel, you will lose all 
your changes.  

4. Upon entering the load's cycle parts, the Load graph shows you the defined 
custom duty cycle. 
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Figure 12: Overload definitions 

 

Rms over the load cycle and Rms10 during the worst 10 minutes are calculated. When 
overloads are severe (long lasting) and thermally important, DriveSize computes a higher 
continuous load value which it uses as the base power later. For motor selection it is 
possible to skip RMS computing form Tools menu’s options. Notice that thermal load 
capability against overloads is not checked at all when RMS computing is off. 

 
Table 8: Duty cycle view abbreviations 

Abbreviation Meaning 

Rms Rms value for the whole duty cycle 

Rms10 Rms value for the duty cycle’s worst 10 minutes 

Highest load The highest load for the user’ s duty cycle 

100% Base power in kW 

Cont.load Calculated continuous load in kW 

Overload Calculated overload in percent 
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Drive or inverter load 
Regardless if motor has many overloads or not the drive load can be viewed with toolbar 
button Duty Cycle or from menu Overload definitions. For drive the dialog tittle is called 
Overload currents.  

Many overloads 
1. Define the duty load by intervals, min frequency, max frequency, current and cos 

phi.  

2. To enter these values, click a cell in the table and type the new value. Use the 
arrow keys on your keyboard to move inside the table.  

3. To accept your custom duty cycle, click OK. If you click Cancel, you will lose all 
your changes.  

4. Upon entering the load's cycle parts, the Load graph shows you the defined 
custom duty cycle. 

 

Line supply unit load 
You often must optimize a line supply unit selection and define the power requirements 
manually. DriveSize has fields for regenerative power when the supply unit type is RRU 
and ISU. The Pmax motoring power value is the sum of positive Pmax motoring values 
including losses. The same logic is used for Pmax generating, Pcont motoring and 
Pcont generating values as well. 
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Figure 13: Line supply unit load  

DriveSize fills in the time fields with defaults. Check and, if necessary, modify the times 
and power values. DriveSize does not know the mutual timings of different inverters. 
  



40   Special features 

 

 

 

Customer-specific motors 
Some motors are called customer-specific because they are not picked from any list, but 
the rated power and frequency are computed from load requirements. When you select 
HXR, AMI and NXR motors, ABB Sophiè automatically selects the number of poles and 
the field weakening point (Fwp frequency). After the automatic selection you can alter 
the value of field weakening frequency between the given limits. The minimum and 
maximum limits for field weakening are shown in the selected motor data. Additionally, 
there is also a value for the recommended maximum (Rec). Before you change the value 
of Fwp frequency, select the pole number. When the value of the pole number is 
changed, the Fwp frequency returns to Automatic. Figure 14: Drop-down list of field 
weakening frequency shows the optional field weakening frequencies for a customer-
specific motor. 

ABB Sophiè starts automatically when the program cannot find any standard motor and 
the Motor type is Auto selection or if you have selected HXR & AMI motors as the motor 
type. 

Figure 14: Drop-down list of field weakening frequency  
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Existing motors 
You can define an existing induction motor or existing synchronous motor with 
multidrives. Figure 15: Existing Motor dialog box shows the dialog for an existing 
induction motor. The loadability curves of the ABB standard motors are used for existing 
motors. DriveSize assumes that the existing motor is already installed and driving the 
load. The loadability of an existing motor is not checked, but the graphs show if it is 
undersized according to the rules for standard motors.  Existing synchronous motors are 
normally high torque and high power motors and maybe also used in wide operating 
speed at constant power range.  They are electrically exited motors. 

Figure 15: Existing Motor dialog box 

Low inertia motors 
Low inertia HDP (high dynamic performance) motors have been designed to cool down 
effectively. The square frame design and high overload capacity gives the motor an 
excellent dynamic response with Machinery and Industrial drives.  The max speeds are 
high but depend on ball/roller bearing selections and vertical/horizontal mounting 
selection.   Motors are F-class. 

 

User motors 
You can let desktop application DriveSize select motors from your own motor list. This 
section describes how you can import your own motor database.  

The format of the motor list is an Excel worksheet with specified column headers and one 
row for the information of one motor. The motor list is expected to start on the first 
worksheet in the book and the upper left corner is cell A1. Before you can use the motor 
list, import it to a UserMotor database in DriveSize. The import is always a full import and 
all previously existing user motors are removed when you import a new list. 

User motors are used independently from supply frequency, but the motor voltage must 
match the supply voltage. The rating value conversion from one voltage to another is not 
done for user motors (You can make the conversion in Excel.) Different voltages must 
have separate rows in the database. 
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Creating a user motors file 
Enter the motor data and loadability curves in UserMotors.xls. On 32-bit operating 
systems you can find this file by default in your working directory in C:\Program 
Files\DriveWare\DriveSize\VsdSize20\System. On 64-bit operating system the same file 
is located by default in C:\Program Files (x86) \DriveWare\DriveSize\VsdSize20\System. 
You can change the file name but not the extension. 

 

Importing from a file 
To import new data to the database, select File -> User motors -> Import from file. This 
action overwrites the existing UserMotor database. 

Figure 16: Import Database window  

The import function validates the information in the Excel sheet before updating the 
database. The validation rules are: 

 Correct column headers 

 Correct data types (text, numeric) 

 All numeric values must be > 0 

 Text values must fit into a maximum length 

 The frequency column must be between 8…400 (Hz) so that also values 
other than 50 Hz or 60 Hz are accepted. 

 The voltage must be known by DriveSize 

In case of import errors, the program tells you which values are not accepted, and the 
import is cancelled.  The import date is stored in the General table and it is visible in the 
About box. 

If there is at least one motor imported to the database, a new item is added to the Motor 
type list: User defined in the motor specification grid.  When you select User defined, 
DriveSize updates the Family list with all families from the Database. The other 
specification items are: 

 Family: “Not specified”, + rest of list from the database 

 Pole number: “Automatic”, 2, 4, 6, 8, 10, 12 

 Design: Not specified, Basic, High-Output 

 Connection: Not specified, Y, D 
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 IC class: IC411, IC416 

 IM class: IM10001, … 

 Max speed rule: Standard 

 Temp rise: Not specified, B, F 

 Motor Tmax Margin: 20%, 30%, 43% 

 

To enter loadability curves 
In the Excel list, you can give a reference to an existing loadability curve in the standard 
databases (for example, IEC, Existing and so on). If an empty loadability curve name is 
found, the existing motor type is assumed. 

You can also import the loadability curves for your motors. Use the same Excel file 
(UserMotors.xls) to import loadability curves. The loadability curve must start from the 
zero frequency and extend to 1 (relative). The number of loadability curves is unlimited. 

To import motor loads from file 
You can import several pre-collected motor loads at once (desktop application). Fill in the 
motor loads to MotorLoadData.xlsx. By default, you can find this file in your working 
directory in C:\Users\[user]\DriveWare\DriveSize\VsdSize\System. You can change the 
file name but not the extension. 

  
 Name: number of characters 0...24  

 Load type: Constant power, Constant torque, Constant torque/power or 
Pump/fan load 

 Speed, min: number in rpm  

 Speed, base: number in rpm 

 Speed, max: number in rpm  

 Power, base: number in kW 

 Overload, base: value in percent, relative to base power 

 Overload, max: value in percent, relative to base power 

 Overload, time: overload duration in seconds 

 Overload repeating: total cycle duration in seconds 

1. To import the motor loads data, select File -> Import motor loads.  

2. Select file like MotorLoadData.xlsx.   

3. The motor loads appear in the System tree.  

4. Continue with DriveSize as usual.    

The purpose of importing motor loads is to speed up dimensioning process when motor 
load list is available and contains several motors. 
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Results 

Contents of this chapter 
This chapter describes how to interpret the Results shown on screen.  

Selection results 
DriveSize always tries to select some unit. The selection may not be optimal, but it 
provides a result quickly. When you change the input data, you get another result.  
DriveSize computes the selections quickly but you make the final decision. Figure 17: 
Main DriveSize/VSDSize window shows an example of the motor results. 

The catalog data is on main window, but more detailed information can be found in the 
Selection Result view where results appear numerically or in the Graph view where 
results appear graphically. You can make your own selection in the Manual selection 
view. The List of Selected is useful when there are plenty of motor drives.  

 

Result view 
The Result view shows the results in a numeric form for the item you have highlighted. 
The view is similar for motors, inverters and incoming units. The Specifications data 
shows the user requirements. The Catalogue data displays the name plate/catalog data. 
The Selection data has columns for Required, Result and Margin values. The required 
data is calculated from the user load demands. The result data is based on selected unit 
(motor, drive and so on). The margin indicates the percentage of capacity still available. 
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 Figure 17: Main DriveSize/VSDSize window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18: Result view for motors 
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Table 9: Selection data for motors 

Torque (Nm) 

min, base, max 

Torque at the user-defined speed: Minimum, base, maximum speed. 

Power (kW) 

min, base, max 

Power at the user-defined speed: Minimum, base, maximum speed. 

Overload (Nm) 

min, base, max 

Calculated overload torque at the user-defined speed: Minimum, base, 
maximum speed for the user-defined time. 

 

Table 10: Selection data for inverters 

Icont (A),  

Imax (A) or  

Imax start (A) 

Calculated current load for an inverter in two situations:  

 Continuous load and maximum load for the user-defined time 

 Maximum load at start is shown in case the load type is One time at start 
overload 

Temperature Temperature margin in percent for the IGBT module. There is also an additional 
temperature margin for other components like a choke when liquid cooled. 

 

Table 11: Selection data for diode supply units 

Power (kW) 

mot cont,  

mot max, 

gen cont, 

gen max 

Calculated power load in two situations:  

 Continuous load  

 Maximum load for the user-defined time 

DC-current (A) 

cont motoring, 

max motoring, 

cont generating 

max generating 

Calculated DC bus currents in two situations:  

 Continuous load  

 Maximum load for the user-defined time 

Temperature 

mot temp, 

gen temp 

Temperature margin in percent. There is also an additional temperature margin 
for other components like a choke when liquid cooled. 

 

Table 12: Selection data for IGBT supply units 

Power (kW) 

mot cont,  

mot max 

Calculated power load in two situations:  

 Continuous load  

 Maximum load for the user-defined time 

AC-current (A) 

cont motoring, 

max motoring 

Calculated current and power: 

 Continuous load  

 Maximum load for the user-defined time 

Temperature 

mot temp 

Temperature margin in percent for a supply unit. There is also an additional 
temperature margin for other components like an LCL filter when liquid cooled. 

 

Table 13: Liquid flow sums of line-up for LC multidrives 

Total flow (l/min) Calculated total mass flow for this line-up. The liquid flow of line supply unit is 
shown in the catalogue data table of the LSU result sheet. 
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Heat loss (kW) Calculated loss power for that line-up. 

The selection data includes margin values. When the margins are positive, the unit meets 
the requirements. 

Note: When the drive type is ACS800 or ACS880, where a thermal model is used, the 
margin of continuous current can be negative when the ambient temperature is below 
40 °C. 

Heat losses and efficiency reports 
Since 2004 DriveSize have computed the motor and drive losses in multiple load points.  
This method is described on ABB Web documents.  We favoured the loss numbers 
instead of efficiencies.  These heat losses are shown on Result screens. Notice that you 
can print all efficiency reports at once. This function is available under File menu’s Print 
option (or Ctrl-P). 

During 2014 European standard EN 50598-2 adopted the same ideas with the exception 
that motor losses are computed based on loss measurements with loads 25%, 50%, 75% 
and 100% full speed.  These losses for drive are shown under Selected drive data.  

DriveSize will maintain older loss computing for those products which does not have 
EN50598-2 numbers and for motors.    
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Graph view 
The Graph view helps you to check how well the unit fits the requirements. The graphs 
display load and motor torques, load and motor powers and load and inverter currents. 
Figure 19: Graphs for motor shows the graph for load and motor torques as a function of 
speed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 19: Graphs for motor  

In the view, a legend explains the curves. Each curve has its own color. 
 

Table 14: Torgue [Nm] curves in the Motor graph 

max. loadability Motor maximum capability as a function of speed 

max. load User-defined maximum load (overload) 

cont. loadability Motor continuous loadability – thermal limit 

cont. load User-defined continuous load 

 

Table 15: Current [A] curves in the inverter graph 

max. loadability Inverter maximum capability 

max. load User- defined maximum 

cont. loadability Inverter continuous loadability 

cont. load User-defined continuous load 
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Manual selection view 
In the Manual selection view, you can view and select a smaller or larger unit instead of 
your current selection (made by the software or by your own previous selection). The 
selected unit has number 0 and its row is highlighted. Smaller units have a negative 
mark. Larger units have a positive mark. The table includes some catalogue values and 
calculated margins to help with the new selection process.  

Figure 20: Manual selection view for drive shows the alternative selections. The view is 
available for motors, drives/inverters and supply units. 
 

Table 16: Items in Manual selection view, motor table  

Type Motor’s type designation 

Code Motor’s product code or generation code (filter option available) 

PU Production unit (filter option available) 

Efficiency class Motor efficiency class 

Winding Standard, restamp or special design. 

Power (kW) Rated power 

Poles Pole number 

Speed (rpm) Nominal speed 

In (A) Nominal current 

Tn (Nm) Nominal torque 

Tmax/Tn Maximum torque / Nominal torque 

Tcont margin Continuous load margin. The smallest margin over the complete speed range. 

Tmax margin Maximum load margin. The smallest margin over the complete speed range. 

Im (A) Calculated continuous load current 

Immax (A) Calculated maximum load current 
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Table 17: Items in the Manual selection view, inverter table 

Type Inverter’s type designation 

Apparent power [kVA] Inverter’s apparent power 

Power [kW] Inverter’s nominal motor power 

Icont [A] Nominal continuous loadability current 

Icont margin Calculated margin for your continuous load 

Imax [A] (peak) Nominal maximum loadability current 

Imax margin Calculated margin for maximum load 

Selection method Selection criterion 

Temp. margin Calculated temperature margin 

 

Table 18: Items in the Manual selection view, line supply unit table 

Type Line supply unit’s type designation 

Apparent power [kVA] Line supply unit’s apparent power 

Power margin Calculated continuous power margin for motoring load.  

Current margin Calculated continuous current margin for motoring load with required power. 

Selection method Selection criterion 

Temp. margin Calculated temperature margin 

To select a different unit, click the row. To verify your selection, click OK. Your selection 
is highlighted. Filter options are available in motor table for Code and PU items. This 
makes it easier to find certain motor type from long list. Click Lock checkbox in System 
configuration/Selected motor data to keep manual selection. 

List of selected 
List of selected displays the selected units. The list contains: Type designation, Unit 
name and Selection status, which shows whether you or the software made the final 
selection.  

Figure 21: List of selected
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Network Check 

Contents of this chapter 
This chapter describes computing of the supplying network issues.   

Harmonics calculation is based on discrete Fourier transformation and tabulation.   
Please refer to Technical guide book from ABB for the basics. 

Network Check view 
With Network Check you can calculate typical values for: 

 the THD, harmonics and power factor for an individual drive 

 the THD, harmonics and power factor for a line supply unit 

 combined harmonics for several units at transformer level 

Both voltage and current harmonics are calculated. DC voltage calculations provide DC 
link voltage.  

DriveSize will always compute the main-wave = first harmonic = base current as well and 
more importantly compare the harmonics on this main-wave. Some standard papers give 
harmonics current limits compared to reference currents Iref and as function of short 
circuit power.   The purpose is good.  The intention of DriveSize is on the other hand to 
give user the harmonic levels which are applicable to user’s way of loading the particular 
drives.   Please notice that drives produce higher THD% if loading is partial. With full 
power and consequently with Iref the THD% values are probably smaller.   

Tip: Compute the combined harmonics, not harmonics for individual drives. Parallel 
drives will smoothen and, in some cases, compensate each other. Combine ISU and 
DSU drives. 
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Figure 22: Network Check view.   

  

Interharmonics 
DriveSize calculates total harmonics distortion with interharmonics and with grouping.  
THDs are computed up to 40th harmonic and additionally up to 50th harmonic for primary 
side.  In the first case the divider is I1 and in the second case the nominal current of 
transformer.     

Un/U1 and In/IL limit values are upper limit guidelines for primary. With In/IL values the IL 
is the transformer nominal current.    
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Table 19: Network and Transformer Data items 
Primary voltage Network voltage on the primary side 

Secondary voltage Network voltage on the secondary side 

Frequency Network frequency 

Network Sk Network short-circuit power MVA. Currently the maximum value is 900 MVA 

Transformer Sn Transformer nominal power 

Transformer Pk Transformer load loss power in kW 

Transformer Zk Transformer short-circuit impedance in percent 

Cable quantity Parallel connected cable quantity 

Cable length Length of the cable 

 

Table 20: Supply Unit items 

Lac (µH) AC choke inductance 

Ldc (µH) DC link inductance 

Cdc (mF) DC link capacitance 

Pdc (kW) DC power; the default value is base power plus the losses in the motor and 
inverter. 

 

Table 21: Result items 

cos Φ1 Fundamental power factor, main wave power factor 

Tot power factor Calculated total power factor with the harmonics included 

Udc (V) Calculated DC voltage 

 

Table 22: Harmonic items 

Voltage THD (%) Voltage total harmonic distortion 

Current THD (%) Current total harmonic distortion 

Limit Harmonics limits specified in IEC519 standard. Limits depend on calculated short 
circuit ratio. 

n Harmonic order number 

f (Hz) Harmonic frequency 

Current (A) Harmonic current 

In/I1 Harmonic proportional current to base current 

Voltage (V) Harmonic voltage 

Un/U1 Harmonic proportional voltage to base voltage 
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To get network check 
1. Highlight the transformer or drive and click Network check in the toolbar.  

2. The Network Check view opens.  

3. If necessary, adjust the Pdc and other settings.  

4. Click Calculate.  

Note: The network data you fill in Network Check does not have effect on the network 
data in the main window. 

To view the harmonics output as a table or a graph, select the Table or Graph radio 
button in Show Mode. When you select the graph view, you can choose between the 
voltage and current harmonics. 
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Printing and saving results  

 

Contents of this chapter 
This chapter gives information on the printing functions.  The printed results are meant to 
be used as appendixes for offer, request for offer or just for documentation purposes. 

Instead of printing we encourage you to save the results on electronic format.  This is one 
way to avoid consumption of printers and paper.   

Printing the results 
You can use the printing functions for two purposes:  

 exporting the project information to Excel or LibreOffice Calc, which can 
be used as shopping lists for motors and drives.   To do this, select 
Preview. 

 printing on paper.  To do this, select Print. 

In the Print dialog, define the information you want to move to Excel or Calc.   

Figure 23: Print dialog  

 



Printing and saving results   57 

 

 

Many DriveSize views have a Report button too.  

 

Efficiency and heat loss report 
Click the Efficiency report button in Motor data view to see the efficiencies and losses 
in a printable form. Note that print All data sheets does not contain the Efficiency report 
sheet. This sheet is available for single drives. Select All efficiency reports if you want 
to print all Efficiency report sheets at once. This function is available under File menu’s 
Print option. 

Network check report 
Click the Report button in the Network Check view to see the printable result sheet of 
the harmonics.  
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Overview of MCSize 

 

General 
The name MCSize refers to motion control and machinery drives and the MCSize 
software is meant to be a fast technical computing tool for all users who need to select 
electrical drive system components. Typically, a sizing process starts from the selection 
of mechanics and motion profiles. Also, gears are an essential part of the system. 
Because the automatic gear ratio optimization is not currently included in the software, 
users are expected to use their common knowledge when setting the gear ratios, since it 
is an important part of cost effective solutions. 

The motor selection is based on technical facts only, usually on the torque requirements 
of the motion and mechanics. MCSize does not contain cost or price information and, 
thus, cost optimizing must be performed manually. After the calculation of motor choices, 
the drive is then selected based on motor actual currents. The single drive selections and 
the sizing of line converter with one or several inverters are supported.   

To help new users MCSize inserts reasonable default values to the required input fields. 
This way the users can command the software to select the motors and drives right away. 
The software for example gives the default value of 0.2 m for the driver roller of the 
conveyor, as a value of 0 m would cause the software to give unnecessary error 
messages about missing data. However, it is easy to override the default values and save 
new values for future use.  

In addition, MCSize provides plenty of intermediate results for users. This helps the user 
to: 

1. double-check results 

2. easily find good and cost-effective solutions 
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3. use some of the computed data when the drive or motor is started and commissioned 
with mechanics. 

Functions 
With MCSize you can: 

 Compute Torque requirements for various mechanical arrangements 

 Compare gearing alternatives 

 Select the correct size of a drive and the correct motor combination 

 Select a suitable line converter for the regenerative drive system 

 Select the proper braking chopper and resistor 

 Compute multiple axis systems 

 Export the produced results from MCSize to the .xls format. 

  

Opening MCSize project 
In the DriveSize New project view, double click the Motion control drives icon.  On the 
tabs Existing and Recent you can open projects saved earlier. 

First Drive Type dialog opens for a start. Select the type of drive you want to start with. 
There is a possibility to add single drives and regenerative drives to the same project. It is 
possible to convert single drive to line converter supplied unit later. 

 

 

 

 

 

 

 

 

 

 

Figure 24 First Drive Type dialog box 
 

The motion control project files have a unique file extension (.mdd).   
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Sizing of motion control drives 

 

Sizing procedure overview 
System configuration tree 
The System configuration tree displays an overview of the frequency converter system 
of all axis.  It shows the type designations or names of units in the tree format (see Figure 
25). The order of units follows the power flow.   

MCSize includes different displays for the transformer, supply, drive, motor, gearings, and 
motion profile and mechanics data. When you click on an item in the System 
configuration tree, the display will change accordingly. 
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Figure 25 System configuration tree 
 

The System configuration tree includes the following icons: 

 Transformer 

 Supply (when regenerative drive) 

 Drive 

 Motor 

 Gearing 

 Motion profile and mechanics 

Order of selections 
Dimensioning selections can be performed for example in the following logical order: 

1. Select a voltage [V] and Frequency [Hz] of the system. 

2. Select the type of application. 

3. Enter motion profile data. 

4. Specify data for mechanics. 

5. Select gearings and enter parameters. 

6. Select motor specifications and motor. 

7. Select drive specifications and drive. 

8. Optionally select supply unit and transformers 

To add a second axis, select Insert > Drive + Motor +Mechanics or Insert > Supply + 
Drive + Motor +Mechanics from the menu bar and repeat the selections from 3 to 7. 

However, MCSize allows you to select and modify units at any level, and you can perform 
the dimensioning selections in any order. For example, you can easily change the supply 
voltage and frequency at any stage. 
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Transformer level 
The default network voltage is 400V, 50Hz.  To modify these open the transformer 
display by selecting the Transformer icon from the System configuration tree.  Select 
the Secondary voltage [V] setting from the drop-down list and Frequency [Hz] setting.  
These are linked and will affect what drive series are available at drive level. 

Figure 26 Transformer load data definition 

 

MCSize also displays the Calculated load power [kVA] when drive and motor loads are 
on place.   You may override it by typing a value for Load power [kVA].  

You may insert data in the Specification field of the Transformer load display: 
Specification Options 

Name Any text or number string. This will also show up in 
reports and, depending on the Tools/Options 
settings, on screen. 

Type Dry, Oil 

Table 23 Transformer load specifications 

  



Sizing of motion control drives   63 

 

 

 

Supply level data 
Supply level is available if regenerative drive was selected in the beginning.  The load 
data is normally derived from underlying drives etc.   To view supply load data, open the 
Supply load display by clicking the Supply icon in the System configuration tree. 

Two Profile type options are available: Manual and Derived. Derived load means that 
load is calculated based on mechanics connected to that regenerative supply unit. The 
loads that have identical cycle time are collected to own groups. It is also possible to 
define phase shift between loads with same cycle time (see Figure 27). 

Figure 27 Supply data definition 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 28 Manual supply data definition 

Select manual profile option to enter load manually. These inputs override the load 
calculated on mechanical load. When manual profile is selected then Supply Unit Profile 
view opens.  Manual data can consist on up to 50 load points. 
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Modifying supply specifications 
You can set the following specifications for the regenerative supply: Line converter 
amount, type, line filter, IP class and switching frequency. To modify drive specifications, 
click on the desired item. Select new values from the drop-down lists or type the new 
value to the field. 
 

Specification Options 

Name Any text or number string. This will also show up in 
reports and, depending on the Tools/Options 
settings, on screen. 

Supply amount Number of similar drives with range 1 – 100 for one 
branch in the System configuration tree 

Type Air cooled, Cold plate 

 

Line filter Included 

 

IP class Not specified 

IP20 – This selection means that the user is 
specifically limiting the choices to the IP20 protection 
class. 

Switching frequency 3, 4, 5, 8 or 16 kHz 

 

Table 24 Supply unit load specifications 
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Drive input data 
Normally the drive load is derived from underlying motor and its loads. To view drive load 
data, open the Drive load display (see Figure 29) by clicking the Drive icon in the 
System configuration tree. White fields are editable and grey fields are calculated 
based on profile, mechanics, gearings, and motor. The calculated values include primarily 
dimensioning criteria. The inverter is loaded with the calculated motor currents, frequency 
and power factor.  

You can change the motor currents but note that the other motor data and the given 
speed profile will still be used. In Table 25 you can see the explanations of abbreviations 
that are used on the display. 
 

Abbreviation Meaning 

RMS-current Root mean squared value for the whole duty cycle 
currents 

Max-current The calculated peak value that occurs during the 
duty cycle 

Table 25 Explanation of abbreviations in Drive load display settings 

More complicated inverter profile 
The text custom is shown in Drive load display’s current and duration fields when the 
Duty type of motion profile is Multiform cyclic. Open Inverter profile to see the segmental 
currents. You can also enter the new current for each segment.  All the other motor data 
and the given speed profile will still be used. 

Click the        icon or select Data > Motion profile from the menu to open Inverter profile. 

 

Figure 29 Drive load input data 
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Modifying drive specifications 
You can set the following specifications: the inverter amount, type, cooling, IP class, 
switching frequency, braking chopper and resistor.   The available types depend on 
voltage, which was set on transformer level.  Higher level selections effect lower level 
items. 

To modify drive specifications, click on the desired item. Select new values from the drop-
down lists or type the new value to the field. 
 

Specification Options 

Name Any text or number string. This will also show up in 
reports and, depending on the Tools/Options 
settings, on screen. 

Inverter amount Number of similar drives with range 1 – 100 for one 
branch in the System configuration tree 

Type ACSM1, MicroFlex, MicroFlex e100, MicroFlex e150, 
MotiFlex e100, MotiFlex e180 

Depending on selected voltage. 

Cooling Air cooled, Cold plate  

 

AC choke Yes or No 

 

Overload Mode For MicroFlex and MotiFlex a significant parameter 

300% 3s, 200% 3s, 150% 60s, 110% 60s and Not 
specified.  

 

IP class Not specified 

IP20 – This selection means that the user is 
specifically limiting the choices to the IP20 protection 
class. 

 

Switching frequency 4, 8, 16 kHz. Higher switching frequency will reduce 
the audible noise and give better motor performance 
but will adversely cause losses in the drive and the 
max current providing capability. 

 

Braking chopper Ignored – This selection means that even though the 
internal chopper is used, the losses of it are anyway 
ignored when a drive selection is performed.  

Internal – This selection means that the losses of 
internal chopper are added to drive losses and the 
limitations of the internal chopper are considered 
when selecting a drive. 

 

Braking resistor Not considered – The braking resistor is not selected 
this time.  

Selected – The braking resistor is selected based on 
the motion duty braking power requirements. 

 

Table 26 Drive load specifications 
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Motor input data 
Open the Motor load display (see Figure 30) by clicking the Motor icon in the System 
configuration tree. The calculated values are shown in grey fields.  

Figure 30 Motor load input data 

The calculated values are based on profile, mechanics and gearings. The calculated 
values (RMS-values) are the primarily dimensioning criteria. The calculated torque is a 
peak torque at motor shaft and in the final results the motor inertia is also considered.  
The calculated speed is the speed at the max dynamical power or the speed when the 
calculated peak torque really exists. Only the quadrants that really exist in the application 
are shown in the motor input load view.  
 

Quadrant Description 

Q1 Positive torque, positive speed 

Q2 Negative torque, positive speed 

Q3 Negative torque, negative speed 

Q4 Positive torque, negative speed 

Table 27 The definition of quadrants 
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Modifying motor load specifications 
You can see the input fields for motor load specifications in Table 28. Note that some of 
the input fields are dependent on the selection made in the Motor type field. 
 

Specification Options 

Name Any text or string 

Motor type ServoMotor – Permanent magnet servo motors in 
database,  

InductionMotor – ABB's catalog induction motor,  

ExistingServoMotor – Enter motor characteristics 
case-by-case,  

ExistingInductionMotor – Enter induction motor 
characteristics.  

UserDefinedServoMotors 

Motors per inverter Normally 1 but can be in the range 1 – 100 similar 
induction motors per a drive unit.   

The load is given for one motor. One inverter feeds 
several motors connected in parallel. 

Family According to the Motor type selection, the motor 
family choices are shown. If you have no 
preferences, use “Not specified”. 

 

Polenumber Not specified, 2, 4, 6, 8, 10, 12 

 

Feedback type Not specified, Encoder, Resolver 

– With servomotors an encoder motor might give less 
output than a resolver motor because resolver 
motors withstands higher temperatures. 

Max inertia ratio Not specified, 2, 3, 4, 7, 10, 100. Read the text below 
this table.  

Temp rise class Not specified, B [< 80K], F [<105K]. Not specified 
means that MCSize will use the class given in motor 
catalogs. 

IC Class Not specified, IC-0041, IC411, IC416. 

IC-0041 = enclosed motor without cooling fan. 

IC411 = cooling fan on motor shaft; means lower 
loadability at partial speeds. 

IC416 = separate cooling fan. Choose this option for 
constant torque cases where the min speed is very 
low.  

For large motors there are other choices available. 

Size If specified, limits the selection to the particular shaft 
height of induction motor or the size code of 
servomotor. 

Auxiliary brake No brake, Holding 

Affects to the inertia of motor 

Max speed rule Standard, Metal fan 

Available only for Induction Motors 

Motor Tmax margin 43%, 20% 

Available only for Induction Motors 

Table 28 Motor load specifications 

In inertia calculations, the inertia ratio corresponds to the reflected inertia divided by the 
motor inertia. You can set the maximum acceptable value for this ratio. The ratio will be 
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the motor selection criterion. The ideal ratio for reflected inertia to motor inertia is 1:1, a 
ratio that yields the best positioning and accuracy. The reflected inertia should not exceed 
the motor inertia more than tenfold, if it is important to maintain the control performance. 
Inertia ratio is shown in the manual selection view of motor. 

Motor selection criteria are also based on system voltage which is given as the Supply 
voltage, Frequency and Switching frequency of the drive.    

Catalog induction motors will have the same nominal frequency as the supply, and a 
nominal voltage like the system voltage. The switching frequency of a drive does not 
affect the thermal behavior of an induction motor within MCSize. The output voltage of a 
drive at a field weakening area is less than the system voltage, and this is considered 
when the maximum short-term torque curve is drawn. You will notice this from the fact 
that the turning point of the curve is not exactly at the level of nominal frequency but 
below it.  

On the other hand, the permanent magnet servomotors have non-standard nominal 
voltages and they are always lower than the system voltage. When overloaded at higher 
speeds, the motor voltage will be higher than the nominal voltage but anyhow lower than 
the system voltage. Some reserve voltage must be available for the good performance of 
drives. The nominal values of servomotors are given with a switching frequency included 
in the database. If the setting of drive switching frequency is lower, the nominal values of 
servomotors must be scaled down a bit. If the drive switching frequency is higher than the 
motor’s switching frequency, the motor's nominal values are kept in the original values. 
The best thermal characteristics for a motor are achieved with the highest drive switching 
frequency. 

The system voltage also affects the servomotor maximum speed and available short-term 
torque at high speeds. You will notice this by changing the system voltage, for example, 
from 380V to 400V or 415V, and by monitoring the short-term torque of the same motor. 

If you select ExistingServoMotor or ExistingInductionMotor in the Motor type field, the 
Existing motor window opens. You can see the input fields for existing motor 
specifications for ExistingServoMotor in Table 29. You can see the definition of loadability 
curve in Figure 31. Ensure that the motor data are valid for the same switching frequency 
that you are going to select from the drive specifications. 
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Specification Options 

Type designation Any text or string 

Voltage [V] 400 

Frequency [Hz] 50 

Power [kW] 0.62 

Poles 2, 4, 6, 8, 10, 12, 14, 16, 18, 20 

Speed [rpm] 1500 

Efficiency [%] 90 

IC class IC410 

Temp. rise class B[<80K], F[<105K] 

Mcs 3,9 

Mn 3,9 

Mp0 14 

Mp1 14 

Mp2 14 

n1 1500 

n2 1500 

n3 6000 

Kt 3.04 

Inertia [Kgm^2] 0.001 

Luv [H] 0.004 

Ruv [ohm] 2 

Back EMF [V] 190 

Table 29 Existing motors specifications for Existing Servo Motor. 

Where Kt is torque constant [Nm/A], Luv is line-to-line armature inductance [H] and Ruv 
is line-to-line armature resistance [ohm]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 31 The definition of loadability curve 

You can see the input fields for existing motor specifications for Existing Induction Motor 
in Table 30. 
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Specification Options 

Type designation Any text or string 

Voltage [V] 400 

Frequency [Hz] 50 

Power [kW] 1 

Poles 2, 4, 6, 8, 10, 12, 14, 16, 18, 20 

Speed [rpm] 1000 

Efficiency [%] 90 

Power factor 0.8 

Tmax/Tn 3 

Temp. rise class B[<80K], F[<105K] 

Inertia [Kgm^2] 0.001 

IC class IC411, IC416 

Table 30 Existing motors specifications for Existing Induction Motor. 

Importing own motor list 
You can perform dimensioning with motors from your own motor list. Options are Import 
user motors and Import user induction motors. For User motors, refer to the DriveSize 
manual. 

  



72   Sizing of motion control drives 

 

 

Gearing input data 
To enter gearings data, open the Gearing display (see Figure 32) by clicking the Gearing 
icon in the System configuration tree. You can set a maximum of three gears. Each has 
its own view and data input field. 

This software does not include an automatic gear ratio optimization. Set the gear ratio so 
that the maximum speed is as close to the maximum speed of motor as possible. 

Figure 32 Gearings input data display 

The visible gearing settings are determined according to the selected gearing type. Select 
the desired gearing type from the Type drop down list. The order of gearings from the 
motor to the load is: Motor - 1st - 2nd - 3rd - Load. 

The available gearing type options are: 
 None 

 Gear/gear 

 Gearbox 

 Chain and sprocket 

 Belt and pulley 

 Gearhead  

 

 



Sizing of motion control drives   73 

 

 

Figure 33 Gearing data input field 

Belt and pulley 
 In belt and pulley gearings the power is transmitted from one pulley to another via a belt 
(see Figure 34). The ratio of gearing depends on the diameters of the pulleys. 

 

 

 

 

 

 

 

 

Figure 34 Belt and pulley 

You can enter the driver pulley inertia, driven pulley inertia and coupling inertia directly, or 
you can use the inertia and mass calculator (see chapter 5.1.3. Inertia and mass 
calculator). 

 
 

Setting Explanation 

Driver pulley, Diameter [m] Enter the exact actual diameter of the driver pulley 
for the correct calculation of reflected inertia. 

Driver pulley, Inertia [kgm2] Enter the exact actual diameter of the driver pulley 
for the correct calculation of reflected inertia. 

Driver pulley, Inertia [kgm2] Enter the value of the driver pulley inertia or use the 
inertia and mass calculator. 

Driven pulley, Diameter [m] Enter the driven pulley diameter. The speed of driven 
pulley rotation depends on the belt velocity and the 
diameter of the pulley. Therefore, the exact value of 
the driven pulley diameter is required for the correct 
calculation of the reflected inertia value. 

Driven pulley, Inertia [kgm2] Enter the value of the driven pulley inertia or use the 
inertia and mass calculator. 

Belt mass [kg] Enter the belt mass. It influences the value of total 
inertia. 

Coupling inertia [kgm2] Enter the inertia of coupling at the motor side of the 
gearing or use the inertia and mass calculator. This 
value should also include all additional coupling 
inertia that is not included in the driver pulley inertia 
value, for example, the additional inertia caused by 
the shaft. 

Efficiency [%] With the efficiency setting you can consider the 
losses of torque. In MCSize the losses are assumed 
to happen between the belt and driven pulley. 

Table 31 Belt and pulley gearing settings 
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Chain and sprocket 
In chain and sprocket gearings the ratio of gearing is inversely proportional to the speeds 
of the sprockets, that is, to the number of teeth on the sprockets (see Figure 35). 

 

 

 

 

 

 

 

 

Figure 35 Chain and sprocket 

You can enter the driver sprocket, driven sprocket inertia and coupling inertia directly, or 
you can use the inertia and mass calculator (see chapter 5.1.3. Inertia and mass 
calculator). 
 

Setting Explanation 

Driver sprocket, Number of teeth Enter the number of teeth on the Driver sprocket. 
This value along with the Driven sprocket, Number 
of teeth value generates the gear ratio. The ratio is 
smaller when reducing the value. MCSize accepts 
also the value 1. 

Driver sprocket, Inertia [kgm2] Enter the driver sprocket inertia value or use the 
inertia and mass calculator to define the inertia value. 

Driven sprocket, Number of teeth The number of teeth on the Driven Sprocket. This 
value along with the Driver sprocket, Number of 
teeth value generates the gear ratio. 

Driven sprocket, Inertia [kgm2] Enter the driven sprocket inertia value or use the 
inertia and mass calculator to define the inertia value. 
If you want to use the inertia and mass calculator, 
you must know the gear diameter. 

Coupling inertia [kgm2] Enter here the inertia of coupling at the motor side of 
that gearing. This value should also include all 
additional coupling inertia that is not included in the 
driver pulley inertia value, for example, the additional 
inertia caused by the shaft. 

Efficiency [%] With the efficiency setting you can consider the 
losses of torque. In MCSize the losses are assumed 
to happen between the chain and driven sprocket. 

Chain mass [Kg] Enter chain mass information. It affects the value of 
total inertia. 

Driver sprocket diameter [m] Enter the true diameter of the driver sprocket to 
define the chain's effect on the reflected inertia value. 

Table 32 Chain and sprocket gearing 
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Gear/gear 
The gear ratio of gear construction is inversely proportional to the gear speeds, that is, to 
the number of teeth on the gears (see Figure 36). The correct gear ratio is required in the 
calculation of reflected inertia. You can enter the driver and driven inertia directly or use 
the inertia and mass calculator. 

 

 

 

 

 

 

 

 

 

Figure 36 Gear/gear 
 

Setting Explanation 

Driver gear, Number of teeth Enter here the number of teeth on the Driver gear. 
This value along with the Driven gear, Number of 
teeth value generates the transformation ratio. 
MCSize accepts also the value 1. 

Driver gear, Inertia [kgm2] Enter the driver gear inertia value or use the inertia 
and mass calculator to define the inertia value. If you 
want to use the inertia and mass calculator to define 
the inertia value, you must also know the driver gear 
diameter. 

Driven gear, Number of teeth The number of teeth on the Driven gear. This value 
along with the Driver gear, Number of teeth value 
generates the transformation ratio. 

Driven gear, Inertia [kgm2] Enter the driven gear inertia value or use the inertia 
and mass calculator to define the inertia value. If you 
want to use the inertia and mass calculator to define 
the inertia value, you must also know the gear 
diameter. 

Coupling inertia [kgm2] Enter the inertia of coupling on the power input side 
of the gearing or use the inertia and mass calculator 
to define the inertia value. This value should also 
include all additional coupling inertia that is not 
included in the driver pulley inertia value, for 
example, the additional inertia caused by the shaft. 

Efficiency [%] Enter the efficiency. With the efficiency setting you 
can consider the loss of torque. In MCSize the losses 
are assumed to happen in the teeth of gears. 

Table 33 Gear/gear gearing settings 
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Gearbox 
The gearbox is an enclosed gearing, that is, a planetary gear for the gearing of higher 
rotation speed (see Figure 37). The purpose of a gearbox is to achieve output with high 
torque and low speed. The gearbox is often integrated into the motor. 

 

 

 

 

 

 

 

 

 

Figure 37 Gearbox 
 

Setting Explanation 

Inertia [kgm2] Enter the inertia of the gearbox or use the inertia and 
mass calculator to define the inertia value. Typically, 
gearbox manufacturers specify only one value of 
inertia. This inertia is valid at the power input of 
gearbox 

Gear Ratio Enter the gear ratio. This value defines how the 
speed of the input shaft is transmitted to the output 
shaft of the gearbox. For example, 3 means that 
three rotations of the input shaft are required for one 
complete turn of the output shaft. 

Coupling inertia [kgm2] Enter the coupling inertia at the power input side of 
gearing or use the inertia and mass calculator to 
define the inertia value. 

Efficiency [%] With the efficiency setting you can consider the 
losses of torque. In MCSize the losses are assuming 
to happen in the teeth of gears. 

Table 34 Gearbox gearing input fields 

 

Gearhead 
A selection of planetary gearheads can be found form database. Click Select push button 
to see the list of available gearheads.  Gearhead option is possible for the 1st gear only. 

There is also a possibility to import an own gearheads data:  

Select File -> Import -> Gearheads to import new data to the database. Notice that 
existing gearhead data will be overwritten! PlanetaryGearheds.xlsx file is available in 
your working directory or C:\\ProgramFiles\DriveWare\DriveSize\MCSize\system by 
default. You can change the file name but not the extension. Enter the gearhead data to 
PlanetaryGearheds.xlsx file and import it.  

The input field of coupling inertia is available also for planetary gearhead.     
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Entering motion profile data 
To open the Motion display, click the Motion profile and mechanics icon (see Figure 
38). Enter motion profile information to the data input fields. When you enter a new input 
value, the program calculates a new motion profile. The results are displayed in the 
Motion results display. The layout of the Motion results field changes according to the 
selected mechanics type, whether linear or rotational. You can also select an optional unit 
for distance. Click Change type to open a drop-down list with options for the type of 
mechanics. 
 

Figure 38 Motion input data 

 
 

Setting Explanation 

Duty type Select the duty type. The Simple cyclic duty type 
consists of just one profile that includes the 
acceleration, continuous speed and deceleration 
segments. If the Multiform cyclic duty type is 
selected, you can create more complicated cycles, 
for example, enter several acceleration and 
deceleration segments. Enter the data in the 
separate Motion profiles display (see Figure 39). 
With several accelerations, it is possible to 
accelerate or decelerate from one nonzero speed to 
another nonzero speed. A motion profile can contain 
a maximum of 50 segments, including acceleration, 
deceleration, constant speed, dwell and hold 
segments. Only simple cyclic is available for Winder 
and Unwinder mechanics. 

Profile type Select the profile type. The available profile type 
options are the following: 

Trapezoidal 1/3, 1/3, 1/3 

Trapezoidal 1/4, 1/2, 1/4 

Triangular 1/2, 1/2 

User defined 

Fractional numbers here refer to the relative times of 
acceleration, continuous velocity and deceleration. 
Acceleration time and deceleration time become 
editable when the profile type is User defined. 

Accel/ Decel type Select the acceleration/deceleration type. You can 
increase the smoothness of motion with this option. 
S-curves are used when it is necessary to limit the 
acceleration change rate (jerk). These curves are 
also used in dynamic braking. The available s-curve 
options are the following: 

Linear 
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1/4 s curve 

5/8 s curve 

Full s curve 

You can achieve the smoothest motion with the Full 
s-curve setting, but it requires higher peak 
acceleration and deceleration to produce an 
equivalent profile. This means that when s-curves 
are used, more torque is required to accelerate or 
decelerate the system inertias. 

Movement distance [m],  

Top speed [m/s] 

Rotational angle [deg] 

Number of revolutions 

Enter the total distance traveled during the cycle. 
Acceleration/deceleration is calculated based on 
given distance and movement time. When linear load 
is selected, the options are Movement distance [m] 
and Top speed [m/s]. When a rotational movement 
type is selected, a drop-down list with three options, 
Rotational angle [deg], Number of revolutions 
and Top speed [rev], appears. 

Movement time [s] Enter the total movement time for one cycle. Includes 
the acceleration, constant speed and deceleration 
segments but does not include the dwell time. 

Dwell time [s] Enter the waiting time between sequential cycles. 

Table 35 Motion input fields 

 

Entering more complex profile 
To enter the more complicated duty type, select Multiform cyclic from the motion input 
data view (see Figure 38). Select a suitable segment type from the drop-down list for 
each segment. Enter the data for different segment types in the input fields and the 
software calculates the rest (see Table 36). MCSize will display an error message in the 
motion profile view when entered inputs are incomplete for example, if the final speed of 
the previous segment does not fit with the new segment. A new row appears 
automatically after you have entered acceptable inputs for the segment. Click the right 
mouse button to delete or to insert a new segment between two segments. Select the 
segment you want to delete or a segment after which you want to insert a new segment. 
The profile is shown also in graphical form. Graph type options Speed vs. time and 
Displacement vs. time are available for graphics. 

There is also a possibility to graphically reshape the profile by mouse. Select Edit from 
Graph options, use mouse and point out the segment you want to divide into two parts. 
Click the right mouse button and select Add point, click the left mouse button and a new 
point will appear. Similarly use Delete line command to remove segments. Select Drag 
from Graph Options, use mouse and left mouse button to move the red dots. 
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Figure 39 Motion profiles display 

Use Graph Settings to change the scale of graph. Enter the new values of axis and click 
Update push button.  The zoom function is available when the total cycle time exceeds 
ten seconds, or the number of segments is ten or more. Select Enable Zoom, use mouse 
and left mouse button to highlight a period you want to zoom in.  Click the  push button 
to zoom out. 
 

Point type Explanation 

Speed & Accl/Decl For the acceleration or deceleration segment. Enter 
the final velocity in the end of this segment and the 
desired value of acceleration. Negative acceleration 
means deceleration when the speed is positive and 
vice versa. 

Speed & Time For the acceleration or deceleration segment. Enter 
the duration or accelerating/decelerating segment 
and the final speed in the end of this segment. The 
initial speed and the end speed must have the same 
sign (both negative or both positive). Reversal is 
possible via zero speed point only. 

Speed & Distance For the acceleration or deceleration segment. Enter 
the final velocity at the end of this segment and the 
desired distance to be travelled during this segment. 
The distance and the speed must have the same 
direction (both negative or both positive) 

Accl/Decl & Distance Segment type for acceleration or deceleration 
segment. Enter the desired acceleration and the 
distance for the segment. Negative value means 
deceleration when the speed is positive and vice 
versa. 
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Accl/Decl & Time Segment type for the acceleration or deceleration 
segment. Enter the desired acceleration and the 
duration of acceleration for the segment. Negative 
acceleration means deceleration when the speed is 
positive and vice versa. 

Dwell segment This is zero speed and no-load waiting segment 
between motion segments. The final speed of the 
previous segment must be zero. Enter the duration of 
dwell segment 

Const. speed – distance only For the constant speed segment. Enter the distance 
traveled during this segment. Speed is the final 
speed of previous segment. The previous segment 
determines the direction of movement. 

Const. speed – time only For the continuous speed segment. Enter the 
duration of constant speed segment. Speed is the 
final speed of the previous segment. The previous 
segment determines the direction of movement. 

Hold segment This is zero speed hold segment between motion 
segments. Hold torque is determined by mechanics. 
Enter the duration of hold segment. The end speed 
of the previous segment must be zero. 

Table 36 Segment types 
 

Setting Explanation 

Segment Sequence number. You can enter 2…50 segments. 

Segment Type Speed & Accl/Decl, Speed & Time, Speed & 
Distance, Accl/Decl & Distance, Accl/Decl & Time, 
Distance & Time, Dwell segment, Const. speed – 
distance only, Const. speed – time only, Hold 
segment. 

Accel/DeclType Select the acceleration/deceleration type. You can 
increase the smoothness of motion with this option. 
S-curves are used when it is necessary to limit the 
acceleration change rate (jerk). The available s-curve 
options are the following: 

Linear 

1/4 s curve 

5/8 s curve 

Full s curve 

You can achieve the smoothest motion with the Full 
s-curve setting, but it requires higher peak 
acceleration and deceleration to produce an 
equivalent profile. This means that when s-curves 
are used, more torque is required to accelerate or 
decelerate the system inertias. 

Time [s] The duration of the segment. 

Speed [m/s], [rad/s] The end speed for acceleration or deceleration 
segment. 

Distance [m], [rad] Angular distance traveled during the duration of the 
segment. 

Accel/Decl [m/s2], [rad/s2] The mean value of acceleration for the segment. A 
positive sign means acceleration to the positive 
direction and vice versa. A negative sign means 
deceleration when the direction of the movement is 
positive and vice versa. 

Total Dist. [m], [rad] Total distance or angular distance from the start 
position to the end position. 
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Table 37 Motion profile inputs for Multiform cyclic load type 

Entering mechanics data 
You can select the type of the mechanical application from the Type drop-down list in the 
Mechanics display (see Figure 40). 

The available mechanics types are the following: 
 Conveyor, which is also the default 

 Cylinder 

 Feed roll 

 Lead screw 

 Rack & pinion 

 Rotating table 

 User defined 

 Winder 

 Unwinder 

Each item has its own view and input fields. User defined, and Cylinder are more 
universal mechanics types for linear and rotational movements respectively. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 40 Mechanics input data 

You can use the inertia and mass calculator to calculate the inertia of mechanical parts 
based on their dimensions, weight and material. To open the inertia and mass calculator, 
click the calculator button next to an inertia input field. 
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Conveyor 

Industrial conveyors are material handling machinery that are used for moving bulk 
materials from one place to another at a controlled rate (see Figure 41). A belt conveyor 
consists of an endless loop belt and a roller system in which idler rollers are often used to 
support the belt. The belt position can be horizontal, inclined or declined. The direction of 
movement is mostly forward but reverse is also possible. 

 

 

 

 

 

 

 

 

 

Figure 41 Conveyor mechanics 
 

Setting Explanation 

Load Mass [kg] Enter the total mass of the load to be conveyed. 

Belt Mass [kg] Enter the belt mass. It affects the value of total inertia 
and the frictional forces. 

Driver roller, Diameter [m] Enter the exact driver roller diameter for the correct 
calculation of driven roller inertia, load inertia, belt 
inertia and idle roller inertia. 

Driver roller, Inertia [kgm2] Enter the value of driver roller inertia or use the 
inertia and mass calculator to define the inertia value. 

Driven roller, Diameter [m] Enter the driven roller diameter for the calculation of 
the effect of the inertia of these rollers on the system 
inertia. 

Driven roller, Inertia [kgm2] Enter the driven roller inertia or use the inertia and 
mass calculator to define the inertia value. The 
rotation speed of the driven roller depends on the 
belt velocity and the diameter of the driven roller. For 
correct inertia value calculations, enter the exact 
diameter of the driven roller. 

Idler roller, Diameter [m] Enter the idler roller diameter for the calculation of 
the effect of the inertia of these rollers to the system 
inertia. 

Idler roller, Inertia [kgm2] Enter the total inertia for all the idler rollers (typically 
there are several idler rollers to support the belt) or 
use the inertia and mass calculator to define the 
inertia value. Notice that you must enter the exact 
diameter of the idler rollers for the correct calculation 
of system inertia. Use zero value when there are no 
rotating idler rollers in the conveyor. 

Coupling Inertia [kgm2] Enter the inertia of the coupling between the 
gearings and the conveyor or use the inertia and 
mass calculator to define the inertia value. This value 
should also include all additional coupling inertia that 
is not included in the driver pulley inertia value, for 
example, the additional inertia caused by the shaft. 
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Efficiency [%] Enter the efficiency percentage of the conveyor 
mechanics. You can consider power losses with 
efficiency. The efficiency value defines how much 
more torque is needed due to the losses. 

Incline Angle [deg] Enter the incline angle between the belt and the 
horizontal plane. Only a positive value of the incline 
angle is possible. Positive distance means upward 
motion and negative distance means downward 
motion. 

Coefficient of friction Enter the coefficient of friction. It considers all the 
frictional losses of the conveyor system due to the 
load and belt. It includes the friction between the 
guides and the belt, the belt and the rollers as well as 
the bearing friction of the rollers. It is assumed that 
frictional losses are independent when the angle is 
inclined. 

Opposing force [N] Enter the sum of forces acting against the belt 
movement, for example, thrust load trying to push the 
load off from the belt. 

Table 38 Conveyor mechanics settings 

Cylinder 

In MCSize the cylinder drive is the universal load type for rotational movement (see 
Figure 42). For example, a load can consist of several cylinders with different diameters 
that are attached to a common shaft. 

 

 

 

 

 

 

 

 

Figure 42 Cylinder drive mechanics 
 

Setting Explanation 

Load inertia [kgm2] Enter the total inertia of the cylinder or use the inertia 
and mass calculator to define the inertia value. 

Coupling inertia [kgm2] Enter the inertia of the coupling between the gearing 
and the cylinder drive mechanics or use the inertia 
and mass calculator to define the inertia value. This 
value should also include all additional inertia that is 
not included in the load inertia value, for example, 
the additional inertia caused by the shaft. 

Efficiency [%] Enter the efficiency percentage (the percentage of 
the input torque provided to output). The losses of 
the cylinder drive mechanics are considered in the 
efficiency. 

Conversion diameter [m] Enter the diameter for thrust force. The thrust load 
diameter is the doubled distance between the center 
of the cylinder shaft and the impact point of the 
opposing force. 
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Opposing force [N] Enter the total sum of opposing forces in this input 
field. The opposing forces include, for example, the 
thrust load acting against the movement at a certain 
radius on the load. 

Table 39 Cylinder mechanics settings 

Feedroll 

You can see the example of feedroll mechanism in the Figure 43. 

 

 

 

 

 

 

 

 

Figure 43 Feedroll mechanics 

 
 

Setting Explanation 

Load mass [kg] Enter the total load of the material to be moved. 

Number of rolls, Driver roller Enter the number of driver rolls in the feedroll. 

Number of rolls, Pinch Enter the number of rolls in the pinch. 

Inertia, Driver roller Enter the driver roller inertia or use the inertia and 
mass calculator to define the inertia value. 

Inertia, Pinch Enter the pinch inertia or use the inertia and mass 
calculator to define the inertia value. The rotation 
speed of the pinch feed roll depends on the strip 
velocity and the diameter of the roller. 

Diameter, Driver roller Enter the exact diameter of the driver roller for 
correct load inertia and tensional torque calculations. 

Diameter, Pinch Enter the exact diameter of the pinch for correct 
system inertia calculations. 

Coupling inertia [kgm2] Enter the inertia of the coupling between the gearing 
and the feed roll mechanics or use the inertia and 
mass calculator to define the inertia value. This value 
should also include all additional coupling inertia that 
is not included in the driver roller inertia value, for 
example, the additional inertia caused by the shaft. 

Efficiency [%] Enter losses that should be considered in the torque 
efficiency. This data defines how much more torque 
is needed because of the losses. 

Strip tension [N] Enter the tensional force or pull through force that is 
needed to achieve the desired material tension on 
the input side of the roller system. 

Frictional force [N] Enter the tensional force that is needed to pinch the 
strip material in the roller system. 

Table 40 Feed roll mechanics settings 



Sizing of motion control drives   85 

 

 

Lead screw 

A lead screw consists of a screw with a nut moving along it. The rotational motion of the 
screw turns to the linear motion of the nut. The high torque and low speed of the linear 
motion can be achieved depending on the value of the screw pitch. The screw position 
can be horizontal, vertical, inclined or declined. Use counterbalance to eliminate the 
gravitation component caused by the incline angle, if necessary. 

 

 

 

 

 

 

 

Figure 44 Lead screw mechanics 
 

Setting Explanation 

Load mass [kg] Enter the total load mass to be transported. 

Table mass [kg] Enter the mass of the table. It influences the value of 
total inertia and on the frictional forces. All the 
linearly moving parts (for example, the nut) are 
considered here. 

Counter balance mass [kg] If counterbalance is used, enter its mass. Note that 
the acceleration of free fall, or 9.82 m/s2, is the 
natural maximum limit for acceleration when 
counterbalance is used. If no counterbalance is used, 
enter zero value to this input field. 

Lead screw Inertia [kgm2] Enter the screw inertia or use the inertia and mass 
calculator to define the inertia. 

Coupling inertia [kgm2] Enter the inertia of the coupling between the 
gearings and the conveyor or use the inertia and 
mass calculator to define the inertia value. This value 
should also include all additional coupling inertia that 
is not included in the screw inertia value, for 
example, the additional inertia caused by shafts. 

Efficiency [%] Enter the efficiency percentage of lead screw 
mechanics. The losses of lead screw mechanics, for 
example, the loss of power due to friction in the 
bearings, is considered with efficiency. The value 
indicates how much more torque is needed due to 
the losses. 

Incline angle [deg] Enter the incline angle between the screw and the 
horizontal plane. Only a positive value of the incline 
angle is possible. Positive distance means upward 
motion and negative distance means downward 
motion. 

Coefficient of friction Enter the coefficient of friction. It considers the 
frictional losses between the table and the support or 
the guide bar. These losses are caused by the total 
weight of the load and the table. This opposing 
component is dependent on the cosine of incline 
angle. 

Opposing force [N] Enter the sum of all opposing forces that affect the 
movement of the table, for example, the thrust load 
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or the preload force. Preload is the opposing force 
that must be overcome before the load starts to 
move. 

Lead screw pitch [mm] Enter the linear distance the nut advances for one 
complete turn of the screw. 

Table 41 Lead screw mechanics settings 

Rack & pinion 

The rack & pinion mechanics consist of pinion and rack gears that transfer the rotational 
motion of the pinion to the linear movement of the rack (see Figure 45). The rack position 
can be horizontal, vertical, inclined or declined. 

 

 

 

 

 

 

 

Figure 45 Rack and pinion mechanics 
 

Setting Explanation 

Load mass [kg] Enter the total load mass to be transferred. 

Rack mass [kg] Enter the mass of the rack including the mass of all 
parts that move linearly. 

Pinion diameter [m] Enter the exact pitch circle diameter of the pinion for 
the correct calculation of load inertia, rack inertia, etc. 

Pinion inertia [kgm2] Enter the inertia of the pinion or use the inertia and 
mass calculator to define the inertia value. 

Coupling Inertia [kgm2] Enter the inertia of coupling between gearings and 
pinion or use the inertia and mass calculator to 
define the inertia value. This value should also 
include all additional coupling inertia that is not 
included in the pinion inertia value, for example, the 
additional inertia caused by shafts. 

Efficiency [%] Enter the losses of rack & pinion mechanics. For 
example, the frictional loss of bearings is considered 
in the efficiency coefficient. The efficient defines how 
much more torque is needed due to the losses. 

Incline angle [deg] Enter the incline angle. It is the angle between the 
rack and the horizontal plane. Only a positive value 
of the incline angle is possible. Positive distance 
means upward motion and negative distance means 
downward motion. 

Coefficient of friction Enter the coefficient of friction. It considers the 
frictional losses between the rack and the support. 
These losses are caused by the total weight of the 
load and the rack. This opposing component 
depends also on the cosine of the incline angle. 

Opposing force [N] Enter the thrust load, that is, the sum of forces that 
effects against the movement of the rack. 

Table 42 Rack and pinion mechanics settings 
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Rotating table 

A horizontally rotating table is controlled through a shaft and a coupling (see Figure 46). 
The table moves and positions bulk loads. 

 

 

 

 

 

 

 

 

Figure 46 Rotating table mechanics 
 

Setting Explanation 

Load mass [kg] Enter the total load mass to be moved. 

Load - center distance [m] Enter the distance between the center of the table 
and the center of the weight. The radius can be 
defined as the average of the inside radius and 
outside radius. The inertia of the load depends on its 
position in relation to the center of the table. 

Table inertia [kgm2] Enter the inertia of the table and the shaft or use the 
inertia and mass calculator to define the table and 
shaft inertia value. 

Coupling inertia [kgm2] Enter the inertia of the coupling between the 
gearings and the rotary table or use the inertia and 
mass calculator to define the inertia value. This value 
should also include all additional coupling inertia that 
is not included in the table inertia value, for example, 
the additional inertia caused by shafts. 

Efficiency [%] Enter the efficiency percentage of input power 
provided to output. The efficiency value considers the 
losses of the rotating table mechanics. 

Opposing force distance [m] Enter the opposing force distance. It is equivalent to 
the distance from the center of the table to the impact 
point of opposing frictional force. 

Opposing force [N] Enter the opposing force. The opposing force can be 
any additional frictional force that acts on a certain 
area from the center of the table. 

Table 43 Rotating table mechanics settings 
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User defined 

User defined is the universal load type for linear movement in this software. The inertia of 
linear load is converted to rotational movement with the conversion diameter defined by 
the user. See the general structure of user defined mechanics in Figure 47. 

 

 

 

 

 

 

 

 

Figure 47 User defined mechanics 
 

Setting Explanation 

Load mass [kg] Enter the total load mass to be conveyed. 

Conversion diameter [m] Enter the conversion diameter. The diameter defines 
the distance the load travels for the full revolution of 
the input shaft. The distance is equal to  multiplied 
by the conversion diameter. 

Coupling inertia [kgm2] Enter the inertia of coupling between the gearing and 
the user defined mechanics or use the inertia and 
mass calculator to define the inertia value. You can 
add any load side rotating inertia to this input field. 

Efficiency [%] Enter the losses of user defined mechanics. For 
example, frictional losses are considered in the 
efficiency. The system's efficiency is defined as the 
percentage of the input torque provided to output. 

Coefficient of friction Enter the coefficient of friction. It considers the 
frictional losses caused by the weight of load. 

Opposing force [N] Enter the sum of any opposing forces that affect the 
movement of linear load, for example, thrust load. 

Table 44 User defined mechanics settings 

  



Sizing of motion control drives   89 

 

 

Winder 

A centerwind type of mechanics winds material around a core or a reeling drum (see 
Figure 48). In this type of winder, the center of coil is driven by motor. In the figure the 
positive direction of angular speed and tension are shown. The MCSize assumes that 
winding starts from minimum diameter to maximum without stops. Due to this the 
Multiform cyclic Duty type is not valid. 

 

 

 

 

 

 

 

 

Figure 48 Winder mechanics. 
 

Setting Explanation 

Max diameter [m] Diameter of the complete coil. 

Min diameter [m] This is the initial value of diameter when rewinding 
starts. In many cases this is the diameter of core or 
reeling drum. 

Coupling inertia [kgm2] Enter the inertia of coupling between the gearing and 
the winder mechanics or use the inertia and mass 
calculator to define the inertia value. You can add 
any load side rotating inertia to this input field. 

Core inertia [kgm2] Enter the total inertia of core and shaft or use the 
inertia and mass calculator to define the inertia value. 
This is the initial value of inertia. 

Efficiency [%] Enter the efficiency percentage of input torque 
provided to output. The efficiency value considers the 
losses of the winder mechanics like bearings. 

Width [m] Enter the width of material. 

Density [kg/m3] Enter material density information. It affects the value 
of inertia. 

Tension [N] Enter the tensional force that is needed to achieve 
the desired material tension. 

Opposing force [N] Enter the sum of any opposing forces that affect the 
movement of reeled material. This force is acting 
against movement at the surface of the coil.   

Table 45 Winder mechanics settings 
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Unwinder 

A centerwind type of mechanics is unwinding material from reel. In this type of winder, the 
center of coil is driven by motor. When the positive directions are according to the figure 
the normal running power is negative and will be shown in second quadrant in torque 
speed diagram. The MCSize assumes that winding starts from maximum diameter to 
minimum without stops. Due to this the Multiform cyclic Duty type is not valid. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 49 Unwinder mechanics. 
 

Setting Explanation 

Max diameter [m] Diameter of the full coil. This is the initial value of 
diameter when unwinding. 

Min diameter [m] This is the final value of diameter when unwinding 
ends. In many cases this is the diameter of core or 
reeling drum. 

Coupling inertia [kgm2] Enter the inertia of coupling between the gearing and 
the winder mechanics or use the inertia and mass 
calculator to define the inertia value. You can add 
any load side rotating inertia to this input field. 

Core inertia [kgm2] Enter the total inertia of core and shaft or use the 
inertia and mass calculator to define the inertia value. 

Efficiency [%] Enter the efficiency percentage of input torque 
provided to output. The efficiency value considers the 
losses of the unwinder mechanics like bearings. 

Width [m] Enter the width of material. 

Density [kg/m3] Enter material density information. It affects the value 
of coil inertia. 

Tension [N] Enter the tensional force that is needed to achieve 
the desired material tension. 

Opposing force [N] Enter the sum of any opposing forces that affect the 
movement of reeled material. This force is acting 
against movement at the surface of the coil.   

Table 46 Unwinder mechanics settings 
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Inertia and mass calculator 
When entering inertia data, for example, in the Motor load, Gearing or Mechanics 
displays, you can use the Inertia and mass calculator v1.1© program developed by 
ControlEng Corporation for the calculation of inertia (see Figure 50). 

Click the calculator button (      ) next to the Inertia [kgm2] value fields to open the inertia 
and mass calculator. 

To calculate the inertia and mass with the inertia and mass calculator: 

1. Select the element shape and, in most cases, enter the dimensions of the mechanical 
component. 

2. Enter the material and density. The mass and the inertia are calculated automatically 
and displayed in the Mass and Inertia fields. 

3. Add the calculated mass and inertia to the Calculation Table field for the calculation 
of total mass and inertia by clicking the      (positive) or       (negative) button at the 
bottom of the Inputs field. To replace an active row from the Calculation table with 
the information in the Inputs field, click the       button. 

4. Feed another mass and inertia information and add it to the totals, if necessary. 

To remove a row from the Calculation Table, activate it and click the  button. To 
display and modify information in a row in the Calculation Table in the Inputs field, 
activate the row and click the        button. 

Note that the unit of inertia must be kg-m2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 50 Inertia and mass calculator 

Sizing examples 
The software includes example project files that include pre-filled input data. With these 
files you can learn quickly how the software works and how to enter data. 

To open a sizing example file: 

Select File > Examples and pick the desired file from the list. 
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Motion control results 

 

Motion and mechanics results 
To open the Motion results display (see Figure 51), click the Motion icon in the System 
configuration tree.  

Motion results, mechanical results and combined results are calculated immediately when 
new data is entered to the Motion and Mechanics input fields. 

Motion results 
The calculation of motion results is based on the Motion profile input data. 

The results are also shown in graphical form. The motion profile graph in the Motion 
results display includes two Graph type display options, Speed vs. time and 
Displacement vs. time. 
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Figure 51 Motion results  

You can see the result fields of the Motion results display in Table 47. These values 
produce the profile that is entered to the input fields of the motion display. 
 

Result Explanation 

Acceleration time [s] Calculated acceleration time. This field is editable 
when the Profile type is User Defined. 

Deceleration time [s] Calculated deceleration time. This field is editable 
when the Profile type is User Defined. 

Acceleration [m/s2], [deg/s2] or [1/s2] Calculated equivalent value of acceleration. Units are 
selected automatically depending on whether linear 
or rotational movement is used. 

Deceleration [m/s2], [deg/s2] or [1/s2] Calculated equivalent value of deceleration. Units are 
selected automatically depending on whether linear 
or rotational movement is used. 

Max velocity [m/s], [deg/s] or [rpm] Calculated maximum velocity 

Velocity at max dyn power [m/s], [rpm] or 
[deg/s] 

When S-curves are applied the movement speed 
where the maximum power is required is not at 
maximum speed but lower.   Applying s-curves might 
allow smaller motors than without because the high 
torque at max speed is avoided. 

Table 47 Motion results  
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Mechanical results  
The values displayed in the Mechanical results field (see Figure 52) are only 
intermediate results and they are true at the input shaft of mechanics. Gearings are not 
considered here. 

 

 

 

 

Figure 52 Mechanical results 
 

Result Explanation 

Opposing torque [Nm] Intermediate opposing torque for mechanics only. 
Motor and gearings are not considered. 

Equivalent inertia [Kgm2] Intermediate inertia at input shaft for mechanics only. 
Motor and gearings are not considered. 

Table 48 Mechanical results 

Combined results  
The combined results for motor selections are displayed in the Combined results field 
(see Figure 53). These results are true at the input shaft of mechanical application. 
Gearings are not considered. 

 

 

 

 

 

 

 

 

Figure 53 Combined results at the driver shaft 
 

Item Explanation 

Max torque [Nm] Calculated maximum torque for given profile and 
mechanics 

Max speed [rpm] Calculated maximum speed for given profile and 
mechanics 

Max power [kW] Calculated maximum torque for given profile and 
mechanics 

RMS torque [Nm] Calculated root mean squared torque for given profile 
and mechanics 

RMS speed [rpm] Calculated root mean squared speed for given profile 
and mechanics. This is the speed that corresponds 
with the calculated RMS torque. 

Speed at max dyn. power [rpm] Rotational speed where maximum torque load exists. 
This appears when s-curves are used.  Applying s-
curves might allow smaller motors than without 
because the high torque at max speed is avoided. 

Table 49 Combined results display items 
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Gearing results 
To view gearing results, click on the Gearing icon in the System configuration tree. You 
can see the results of gearings in the Gearing display, on the right side of the gearing 
settings (see Figure 54). 

 

 

 

 

 

 

 

 

 

Figure 54 Gearing results 

RMS torque and speed are root mean squared results at the input side of gearing. The 
order of gearings is read from the motor output to the mechanics input, that is, the 1st 
gearing is connected to the motor shaft, the 2nd shaft is coupled to the output shaft of the 
1st gearing, and so on. 

At the bottom of the Gearing display you can see the total values of all gearings in the 
Gears totally field. 

 

 

 

Figure 55 Total values of all gearings 
 

Result Explanation 

Total gear ratio Combined gear ratio for all gears 

Inertia due to gears [kgm2] Combined inertia of all gears at motor shaft 

Overall efficiency [%] Combined efficiency for all gears 

Table 50 Gears totally result items 
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Results menu 
To show dimensioning results first select the drive component or the supply unit from the 
tree and then click the        icon or select Result > Dimensioning result. 

Graphs 
To show Graphs, click the        icon or select Result > Graphs. This opens the Graph 
window that displays graphs for the following graph options: 

 Load/Motor graph 

 Inverter 

 Performance and profile graph 

For inverters the following options are available: 
 Current 

 DC power 

To show supply unit DC power graph, select supply from system configuration tree and 
click the graph icon. 

Multi-graph view  
To show several graphs at a time, select the components from the system configuration 
tree. To highlight several components, use the Ctrl key, mouse and left mouse button. 
Press and hold down the Ctrl key when selecting components. Select first the object that 
you want to see uppermost. Two of the graphs are shown at once and you can change 
the lower one by scrolling the graphs. You can show the multi-graph view for all graph 
options. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 56 Performance and profile multi-graph view  
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Reports  
To show Reports, select Result > Reports or click the Report button in the result or graph 
display.  

Motor results  
The motor Selection data is shown in the Motor data field of the Motor Results display. 
Calculated margins are between the following values: 

 Required RMS torque to the nominal torque of motor 

 Required peak torque to the maximum short-term torque of motor 

In the motor data display you can see also Inertia ratio, Max air gap torque, RMS torque, 
Motor copper losses, Specifications and Catalogue data for the selected motor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 57 Motor selection data 

Motor Graph 
You can see the motor results also in graphical form (see Figure 58 and Figure 59). 
Calculated RMS torque at RMS speed, dynamic torques, and limits are illustrated in a 
motor graph. The green torque (speed curve) defines the thermal long-term limits of the 
motor. The red curve defines limits for short term intermittent loads and maximum allowed 
speeds for these loads. These required results are calculated based on the motor air gap 
torque. The effect of motor inertia is also taken into consideration. 
 

The selection criteria for a motor are: 
 Calculated RMS torque must be inside the range of the Cont loadability limit. 

 Dynamic peak torque curve must be inside the range of the Max. loadability limit. 

  



98   Motion control results 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 58 Motor Graph display for ServoMotor 

Please notice in this case the dynamic torque curves. They are shown as black arcs and 
in this close to optimal case they are very close to max torque of motor.  

 

The Motor Graph may have up to four quadrants if the application is braking and running 
in reverse direction at the same time. The required torque curves are not shown in full 
length to keep the graph uncluttered. If s-curves are applied the parts of torque curve 
representing maximum mechanical power are displayed. 

 

Notice that drive’s switching frequency has an effect to torque curves. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 59 Motor Graph display for Induction Motor 
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Drive results 
In the Drive Results display you can see the results and specification data for Selection 
data, Specifications, Catalogue data and Drive losses at RMS speed.  

The selection criteria for a drive are: 
 Peak current trajectory must be lower than the max current limit. 

 Calculated RMS current must be lower than the nominal current. 

 Inverter maximum output power must not be exceeded 

 Additionally, the dynamic thermal limit is checked 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 60 Drive results display 
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Drive Graph 
You can see the drive results also in graphical form (see Figure 61). Current/speed 
curves define the limits for continuous (green) and intermittent currents (red). The latter 
current limit depends on drive heatsink temperature, output frequency and switching 
frequency. Calculated RMS current, actual current trajectory and limits are shown in the 
drive graph.   

Also, this graph can have two quadrants. 
 
 

 

 

 

 

 

 

 

 

 

 

 

Figure 61 Drive Graph display 

Please notice that in this example due to s-curves the acceleration starts smoothly, runs 
most of the time at 2.4A and will easy up at 1520 rpm. The deceleration will happen with 
lower current but with the same idea. 
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Supply unit results 
In the Supply unit data display you can see the results and specification data for 
Selection data (Figure 62), Specifications, Catalogue data and Supply unit losses. 

The selection criteria for a supply unit are: 
 Calculated RMS current must be lower than the nominal current. 

 Peak current must be lower than temperature dependant max current limit.  

 Additionally, the dynamic thermal current and temperature limits are checked. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 62 Selection data of supply unit  

Supply unit Graph  
You can see the supply unit results in graphical form.  There the DC-power of supply unit 
is shown in function of time. The graph illustrates the total DC-power of all inverters 
connected to that supply unit. 
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Figure 63 Supply unit graph display  

Manual selection  
Manual selection functionality is a part of the sizing process and the screen with plenty of 
computed choices is also a part of the results. 

In the Manual selection display you can select a smaller or larger unit instead of your 
current selection (made by the software or by your previous other choice selection). The 
selected unit has number 0 and its row is highlighted. Smaller units have a negative 
mark. Larger units have a positive mark. In this table there are some catalogue values 
and calculated margins to help with the new selection process. In some cases in which 
the overloads are decisive there are no smaller units in the list. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 64 Manual selection display  
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